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ANOTACE 
Cílem této práce je popsat modelování síťové komunikace na konkrétním síťovém provozu s reálným 
zatížením. Vybraný model sítě se přibližuje skutečné síťové topologii telekomunikačního operátora 
poskytujícího síťové služby pro své zákazníky. 
Blíže se zde seznámíme s funkcemi významných směrovacích protokolů EIGRP a BGP a budeme se 
věnovat jejich konfiguraci na vybraných síťových zařízeních. Směrování v síti bude analyzováno v 
jednotlivých projektových scénářích s použitím vybraných směrovacích protokolů. 
Pro protokol BGP bude uplatněno v samostatném scénáři směrovací pravidlo na upřednostnění konkrétní 
síťové cesty při směrování k destinaci, což je obvyklý případ technologie síťového inženýrství. 
Také problematice virtuálních privátních sítí je věnována pozornost v individuálním scénáři, kde se pro 
oddělení sítí s různou důvěryhodností použije specifické síťové zařízení Firewall s následným zavedením 
IP tunelingu pro šifrovanou komunikaci mezi vybranými síťovými entitami v topologii. 
Simulace síťové komunikace je zaměřena na odezvu FTP služby, časovou prodlevu Ethernetu, propustnost 
páteřních linek a na průběh komunikace ve vybraných scénářích. 
Výstupem práce je analýza dosažených výsledků, porovnání grafů a zhodnocení zadaných simulačních 
parametrů. 

KLÍČOVÁ SLOVA 
směrování, EIGRP, BGP, protokol, rozhraní, simulace, IP adresa 

ABSTRACT 
The aim of this work is to describe modeling of network communication with the given network 
performance and load. The selected model of network approaches the real network topology of a 
telecommunication operator that provides network services for the customers. 
We take a closer look on the functions of the significant network protocols EIGRP and BGP and we also 
will focus on their configuration on the selected network devices. Routing in the network will be analyzed 
in the individual project scenarios with a use of selected routing protocols. 
Routing policy will be enforced for a BGP protocol in a separate scenario with an aim to prefer a concrete 
routing path to the destination, which is a common case of traffic engineering. 
The issue of virtual private networks is also taken into a consideration in an individual scenario, where 
there is Firewall as a specific network device used for separation of networks of a different trustworthiness 
and a following introduction of IP tunneling for an encrypted communication among the selected network 
entities within the topology. 
Simulation of the network communication is aimed on the response of FTP service, time delay of Ethernet, 
throughput of backbone links and communication flow in the targeted scenarios. 
The output of this work deals with the analysis of the achieved results, comparison of graphs as well as 
evaluation of the determined simulation parameters. 

KEYWORDS 
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Úvod 

Komunikační síť představuje skupinu síťových nebo technických prostředků umožňujících výměnu 
informací mezi počítači [1]. Koncovým uživatelům je tak zajištěna možnost komunikace podle určitých 
pravidel využíváním společných zdrojů sítě. Rychlý vývoj sítí zaznamenal prudký růst v 60. létech 20. 
století, odkdy již byla vyvinuta celá řada síťových technologií a zařízení. Nezbytnou častí síťové 
komunikace je určování síťových cest, které se i jinak nazývá směrování. 

Směrování jednoduše znamená proces zjištění cesty mezi dvěma sítěmi a děje se na třetí (síťové) vrstvě 
referenčního modelu OSI. Jedná se o proces, který řeší nalezení optimální cesty v síti od zdrojové stanice 
ke stanici cílové na základě cílové adresy umístěné v hlavičce každého paketu, přičemž jsou do něj 
zapojené jednotlivé směrovače mezi zdrojovou a cílovou destinací, a právě k tomuto účelu je vyžadována 
zdrojová a cílová IP adresa koncových stanic. Zařízení, které provádí samotné směrování, se nazývá 
směrovač. K podpoře směrování slouží směrovací tabulka, která obsahuje záznamy o všech sítích, které 
daný směrovač zná [8]. Vkládání záznamů do směrovací tabulky se děje staticky nebo dynamicky na 
základě konkrétního směrovacího protokolu. 

Tento dokument obsahuje podrobnou analýzu směrovacích protokolů EIGRP a BGP při jejich použití na 
směrování toku dat v jednoduché síti. Směrování probíhá nejdříve použitím pouze protokolu EIGRP a 
následně kombinací obou protokolů EIGRP a BGP. Dokument je zaměřený na tvorbu počítačové simulace 
v programu OPNET IT GURU při nasimulování konkrétní zátěže v reálné síti. 

V první kapitole jsou uvedeny zásady pro vytváření projektu a jeho scénářů, výstavba konkrétní sítě, 
konfigurace sítě, nastavení statistik a zobrazení výsledků, na což navazuje kapitola druhá s analýzou a 
popisem dosažených výsledků a následně kapitola třetí obsahuje nové úkoly pro rozšíření oblasti záměru. 
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1. Modelování síťové komunikace v prostředí OPNET IT GURU 

IT GURU vystupuje jako softwarová aplikace umožňující simulaci celé sítě až s několika desítkami 
síťových uzlů. Pokrývá všechny vrstvy referenčního modelu OSI (Open System Interconnect) od fyzické 
vrstvy až po požadavky aplikační vrstvy. IT GURU je schopné nasimulovat velké množství síťové zátěže a 
podat přitom na konci simulace detailní vyhodnocení včetně směrovacích tabulek pro různé směrovací 
protokoly ve zvoleném čase, dále dokáže poskytnout zprávy o zátěži v konkrétních místech v síti a čase 
síťové konvergence. Projekty IT GURU se skládají z jednoduchých scénářů [4], které je možné 
porovnávat při výsledné analýze více případů, které v síti mohou nastat. 

Toto cvičení je zaměřeno na pochopení modelování dvou protokolů vnitřně-doménového EIGRP 
(Enhanced Interior Gateway Routing Protocol) a mezi-doménového BGP (Border Gateway Protocol) a 
jejich vzájemné interakci při směrování jednoduchou IP (Internet Protocol) sítí. 

1.1 Úvod do protokolů EIGRP a BGP 

Samotný Internet vystupuje při síťovém modelování jako řetězec směrovacích domén, přičemž každá 
taková směrovací doména se pak nazýva autonomním systémem (AS) a je řízená samostatnou 
administrativní entitou. Každý autonomní systém má centrální autoritou přirazené 16-ti bitové celosvětově 
jedinečné číslo a pro své vlastní směrování využívá právě protokolů typu RIP (Routing Information 
Protocol), OSPF (Open Shortest Path First) nebo EIGRP. Směrování mezi různými autonomními systémy 
je pak zajištěno pomocí mezi-doménových protokolů, ze kterých je nej používanějším protokol BGP. 

V současném rozsáhlém a proměnlivém Internetu není možné si udržet ve směrovacích kompletní 
směrovací informaci o dané topologii. Tato informace by po pravdě byla i hodně nestabilní a měnila by se 
s každým síťovým výpadkem nebo novým zapojením linky kdekoliv v síti a z tohoto důvodu je směrování 
v rámci celého Internetu řešené hierarchickým způsobem. Při směrování v rámci jednotlivých 
autonomních systémů se používají tzv. vnitřní směrovací protokoly - Interior Gateway Protocols (IGP) a 
naopak pro směrování mezi autonomními systémy se používají vnější směrovací protokoly - Exterior 
Gateway Protocols (EGP). AS vzhledem k externím směrovacím protokolům by se daly chápat jako 
základní jednotky, jejichž struktura již není mimo hranice autonomního systému známa [2]. Každý AS 
potom eviduje své vlastní síťové adresy a pro úspěšné směrování je cílem doručit paket, který patří do 
daného AS, na hraniční směrovač (border gateway) tohoto AS, přičemž o další směrování ke konkrétní síti 
uvnitř AS se již postará vnitřní směrovací protokol. 

1.1.1 Protokol EIGRP (Enhanced Interior Gateway Routing Protocol) 

EIGRP je od roku 1992 patentovaný Cisco směrovací protokol, který je založen na bázi IGRP (Interior 
Gateway Routing Protocol). Podporuje V L S M (Variable Lenght Subnet Mask). Změny v síti šíří rychle, 
takže minimalizuje možnost vzniku směrovacích smyček. Nazývá se taky hybridní protokol, protože 
vystupuje jako výběr těch nejlepších vlastností z distance vector a link-state protokolů. Efektivita 
protokolu EIGRP se vyznačuje velmi rychlou konvergencí, což znamená, že všechny směrovače v dané 
síti mají správné a aktuální směrovací informace a nemůže dojít k chybám během směrování založených 
na špatných informacích v doméně. Důležitou informací je fakt, že oba Cisco patentované protokoly IGRP 
a EIGRP jsou vzájemně kompatibilní, což znamená, že pokud jsou použity v AS se stejným číslem, tak si 
vzájemně posílají cesty a protokol EIGRP si všechny naučené cesty od protokolu IGRP označuje jako 
externí. Hlavním rozdílem mezi těmito dvěma protokoly je to, že EIGRP používá 32 bitovou metriku, 
zatímco IGRP používá 24 bitovou metriku. Rozdíl 8 bitů (256 permutací 1 a 0) znamená, že EIGRP násobí 
metriku IGRP 256-ti [6]. Oba protokoly při stanovení metriky linek standardně zohledňují jen šířku pásma 
(bandwidth) a zpoždění (delay). EIGRP používá k uchovávání informací o síti tři tabulky: 
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• tabulka sousedů, 
• topologická tabulka, 
• směrovací tabulka. 

Do tabulky sousedů se ukládá informace o přilehlých směrovacích (je obdobou tabulky sousedních 
směrovačů - "adjacency table" u protokolu OSPF). Ihned, jakmile se vyskytne nový soused, jeho adresa a 
rozhraní, ke kterému je připojen, se zaznamená. Ve chvíli, kdy soused vyšle tzv. "hello paket", posílá taky 
informaci o tzv. "hold tíme" - což je doba, po kterou se směrovač považuje za dosažitelný a aktivní. 
Jestliže během hold tíme nepřijde hello paket, pak hold tíme vyprší (délka hold tíme je většinou 
trojnásobná než délka intervalu pro vysílání hello paketů). Po vypršení tohoto času se spouští difuzní 
aktualizovací algoritmus DUÁL (Diffusing Update ALgorithm), který přepočítá novou topologii. 

Velmi silným nástrojem protokolu EIGRP je také topologická tabulka, která je vytvořena ze všech 
směrovacích tabulek v daném AS. Směrovací algoritmus DUÁL následně vždy použije informaci z 
tabulky sousedů a topologické tabulky a vypočítá tak nejvýhodnější cesty do všech sítí, samozřejmě s 
nejnižší metrikou a se zaručením bezsmyčkových cest. Nejlepší cesta se označuje za successor routě 
(následující cesta) a je také zaznamenána v topologické tabulce spolu s těmito informacemi [7]: 

• feasible distance FD - nejnižší metrika do každé sítě 
• zdroj cesty - indentifikační číslo směrovače, který jako první informoval o dané cestě (pouze pro 

cesty naučené mimo EIGRP síť) 
• reported distance RD - ohlášená vzdálenost - vzdálenost do daného cíle ohlášená sousedem 
• informace o rozhraní - rozhraní, skrz které je daný cíl dosažitelný 
• status cesty - pasivní znamená, že cesta je stabilní a použitelná, aktivní znamená, že cesta je 

přepočítav ána pomocí DUÁL algoritmu 

1.1.2 Protokol BGP (Border Gateway Protocol) 

Border Gateway Protocol (BGP) je Path vector dynamický směrovací protokol používaný pro směrování 
mezi autonomními systémy (AS). Představuje základní nástroj pro propojení sítí od různých ISP (Internet 
Service Provider). Směrování mezi autonomními systémy má charakteristické požadavky, které se 
nevyskytují v interním směrování. Směrovací tabulky můžou obsahovat stovky tisíc záznamů a 
nej důležitějším kritériem pro výběr optimální cesty nebývá vzdálenost, ale posuzují se nastavitelné 
parametry zohledňující například cenu, také dodatečná pravidla aplikovaná v závislosti na zdroji, cíli, 
seznamu tranzitních autonomních systémů a dalších atributech. 

Nej důležitějším prvkem při směrování mezi AS jsou hraniční směrovače, pomocí kterých se vyměňují 
směrovací informace. Z angličtiny podle těchto hraničních směrovačů bylo také odvozeno jméno tohoto 
směrovacího protokolu, a sice BGP. Právě pomocí BGP si hraniční směrovače vyměňují směrovací 
informace o jednotlivých AS a také o tom, přes které všechny AS je možné se k požadované síti dostat. V 
současnosti se pro verzi IPv4 používá verze BGP verze 4 a pro verzi IPv6 se používá BGP verze 6. 
Protokol BGP podporuje beztřídní adresování CIDR (Classless Inter Domain Routing). S každým 
prefixem (adresou sítě, resp. jejich prvních bitů) se totiž šíří i délka příslušného prefixu. Díky tomu může 
BGP realizovat i agregaci adres [3], 

Velmi důležitou informací je to, že BGP nepracuje s grafem propojení jednotlivých směrovačů a sítí (jako 
to dělá např. OSPF), ale s grafem propojení autonomních systémů, který umožňuje vyhledávat cesty mezi 
sítěmi v různých AS. Cestou (AS PATH) k nějaké síti se v BGP terminologii rozumí posloupnost čísel 
autonomních systémů, přes které se lze k cílové síti dostat. 
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Protokol BGP používa jednoznačnou metriku na rozdíl od vnitřních směrovacích protokolů. Tahle 
jednoznačná metrika volí automaticky vždy nejkratší cesty do jednotlivých cílových sítí tak jako je to 
například u směrovacích protokolů třídy IGP. Směrovací politika, na základě které jsou akceptovány 
zájmy a provozní a obchodní podmínky provozovatelů všech použitých cizích AS, určuje například: 

• do kterých AS necháme tranzitovat provoz přes náš AS 
• ze kterých zdrojových AS necháme tranzitovat provoz přes náš AS 
• kterou výstupní linkou z našeho AS necháme odcházet provoz k daným sítím 
• kterou vstupní linkou do našeho AS necháme vstupovat provoz ke kterým sítím 

Konfigurace protokolu BGP je mnohem více manuální na rozdíl od třídy protokolů IGP, protože je potřeba 
při samotné konfiguraci zahrnout všechny potřebné parametry obsáhlé směrovací mapy, politiky a pravidla 
aplikovaná v závislosti na zdroji, cíli, seznamu tranzitních autonomních systémů a dalších atributech. 
Směrovací pravidla vylepšují dobu konvergence protokolu BGP. Znamená to tedy, že u BGP jsou všechny 
sousední směrovače konfigurovány manuálně s použitím protokolu TCP (Transmission Control Protocol) 
port 179, což je zásadní rozdíl k IGP protokolům, kde sousední směrovače jsou vyhledávány automaticky 
a kde se předpokládá, že cesty do jednotlivých cílových sítí nejsou omezeny žádnými dodatečnými 
podmínkami. Interní BGP se řídí některými dodatečnými pravidly, která nejsou pro externí BGP 
relevantní. Například kvůli ochraně proti směrovacím smyčkám uvnitř AS nesmí směrovač předávat 
v interním BGP informace, které se dozvěděl od jiného interního BGP souseda. 

Při směrování protokolem BGP mezi dvěma sousedními směrovací dochází k výměně celé směrovací 
tabulky, takže směrovač ví celou informaci o směrovací tabulce svého souseda. Směrovače si periodicky 
(obvykle lx za minutu) testují dostupnost každého svého souseda pomocí tzv. "keepalive zpráv". 
Pravidlem je, že pokud soused přestane být dostupný, musí směrovač odstranit všechny cesty vedoucí přes 
tohoto souseda a informovat o změně všechny své ostatní sousedy. V případě, že v daném AS je více 
hraničních směrovačů, je nutné, aby se směrovací informace šířily nejen přes hranice AS (mezi BGP peery 
v různých AS) ale také i mezi těmito hraničními směrovací téhož AS, které můžou být od sebe vzdálené a 
navzájem dostupné pouze přes síť směrovačů s nějakým IGP směrovacím protokolem [2]. Vzniklou vazbu 
mezi BGP směrovací v různých AS nazýváme externí BGP (eBGP), a vzniklou vazbu mezi BGP 
směrovací v tomtéž AS potom interní BGP (iBGP). 

V prvním vytvořeném scénáři této práce je použit pouze protokol EIGRP v celé síti. V druhém scnénáři je 
EIGRP protokol doplněn protokolem BGP a směrování se děje mezi třemi jednoduchými autonomními 
systémy. A následující další dva scénáře představují rozšíření prvního a druhého scénáře. Budeme 
analyzovat směrovací tabulky a následně pak zatížíme síť provozem a budeme generovat výsledné grafy. 

1.2 Vytvoření projektu 

V našem simulačním modelu protokolů EIGRP a BGP si musíme nejdříve vytvořit nový projekt společně 
s prvním scénářem pro směrování s protokolem EIGRP a následně se druhým scénářem pro směrování 
s protokolem EIGRP a BGP současně. 

V téhle části budeme definovat: 
• vytvoření scénáře 
• geografickou plochu 
• síťové komponenty 

1. Spustíme IT GURU 

2. Vybereme položku File > New... a označíme, že chceme vytvořit nový projekt. 
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3. Při výběru projektu klikneme na OK. 

4. Zadáme název projektu " E I G R P v s B G P " a název pro základní scénář "EIGRP", potvrdíme tlačítkem 
OK 

5. Pro vytvoření prázdného scénáře zadáme Create Empty Scenario a klikneme na Next. 

6. Budeme pracovat s podnikovou sítí a tak vybere položku Enterprise a ponecháme možnost Use 
Metric Units zaškrtnutou, klikneme na Next. 

7. Ponecháme zaškrtnutou volbu Specify Size pro geografickou plochu a klikneme na Next. 

8. Nyní hodnotu Size ponecháme v kilometrech a vložíme hodnotu "500" pro X Span a hodnotu "400" 
pro Y Span kvůli zadefinovaní jednotek a potvrdíme tlačítkem Next. 

9. Poté vybereme, s j akými síťovými komponenty budeme pracovat. Z výběru "Model Family" si 
zvolíme sestavy Cisco, internettoolbox, Layer_4_Switch a links, klikneme na Next. 

10. Dialogové okno "Setup Wizard: Review" úvodního nastavení nyní ukončíme kliknutím na OK. 

1.3 Výstavba sítě 

V tomto kroku si vytvoříme celou fyzickou topologii a zadefinujeme si jednotlivá fyzická spojení mezi 
síťovými komponenty. 

Tato část pokrývá: 
• výběr příslušné pozice na mapě 
• kopírování nových objektů 
• modifikaci a editování objektů 

11. V hlavním okně projektu " E I G R P v s B G P Scenario: EIGRP" vidíme teď celou geografickou mapu a 
napravo se nám otevřela paleta objektů Object Palette, která obsahuje všechny potřebné objekty pro 
výstavbu naší sítě, jako např. předdefinované směrovače, přepínače, servery, linky, viz obr. 1.1. 

J^lSlSlÄl^ 
I pSř3 ZZED 

# # # 
nirti Äjtx-ct int/te] :iffe-"te; 

T J A N 1ífliunT_l 

P 

rej r O 

r e ; r c ? r c ? 

• C K Í I E I : - "IK-IÍEI:-- l E i : 

Obr. 1.1: Hlavní okno projektu s paletou objektů 

12. Prozatím můžeme paletu objektů zavřít. 
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13. Protože máme v pozadí zobrazenou celou mapu a my si jí chceme dostatečné přiblížit, aby se nám 
později lépe orientovalo při spoustě objektů, klikneme v hlavním menu na ikonu zoom to rectangle 
dragged by user (viz obr. 1.2). 

ZOOM 

P 
UNZOOM 

:oom to rectangle dragged by user 

Obr. 1.2: Ikona "Zoom to ..." hlavního menu 

14. Na mapě si pomocí levého tlačítka myši označíme levý horní okraj mapy a taháním myši se 
stisknutým levým tlačítkem vytvoříme fiktivní obdélník pro přiblížení co největší plochy na mapě, cca 
450 na 300. 

15. Aktivujeme paletu objektů ve hlavním menu kliknutím na ikonu display all available network 
objects, máme tak připravenou pracovní plochu pro modelování sítě, viz obr. 1.3. 
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f '-'.< lĚZÎ Sj Í ^ ~ - ^ Í J [" f 

<0#MÜM> <G*fl36M% Ot»3$*0> eCK»JW0> « a » » * * 1 * ' <c*»*0Me tfb»4Cto 

& & b i r n r i a 
,<to<ľCO> ^ „ a M j ri^HÍO <C*»tSt$: j ™ ' L f 1 f 1 

g g g Q 9 Ej 9 S 

BEř? « W I y r ~ y 
tCto»i ra> t C w i W í 4ií*l9Ml> <O*»S0i> <DIM2UI LAtfWfißfc 

ÍC*CŮ MQ2(JtNFfUOOb <CéíoZM> ťCCĎAID* ÍCÉ»25I2> <UittM1í> (OKŮ 25U> 
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Obr. 1.3: Pracovní plocha 

16. Pomocí rychlé konfigurace nyní vytvoříme kruhovou topologii se 3 směrovací. V hlavním menu 
vybereme položku Topology > Rapid Configuration a v poli Configuration zvolíme "Ring". 
Potvrdíme OK. 
Dialogové okno Rapid Configuration: Ring vyplníme následovně (viz také obr. 1.4): 
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Node Model: 
Number: 
Link Model: 
Type: 
X 
Y: 
Radius: 

CS_7204_4s_al_e8_fl_sl8 
3 
lOOOBaseX 
Duplex 
100 
70 
35 

Ukončíme konfiguraci kliknutím na OK. 

Hi] Rapid Con f igu ra t ion : Ring 

MODELS 

Node Model |cS_72D4_4s_a1_e! Number 

Link Model I IDDDBaseX T | Type J Duple 

PLACEMENT 

Center 

X [Ť5Ď y [ŤČ Radius |ŠĚ~ 

Select Models... Cancel 

d 

OK 

Obr. 1.4: Rychlá konfigurace kruhové topologie 

17. Kliknutím na nově vytvořenou kruhovou topologii, a to buď postupně označováním jednotlivých 
objektů, nebo jako celek do bloku, jí označíme a přes hlavní menu Edit > Copy nebo příkazem 
Ctrl+C jí zkopírujeme. Poté vybereme z hlavního menu Edit > Paste nebo příkazem Ctrl+V tuto 
druhou kruhovou topologii vložíme na plochu. Opakujeme vložení ještě jednou, abychom získali 
chybějící třetí kruhovou topologii. 

18. Nově získané kruhové topologie pojmenujeme tak, že si postupně označíme konkrétní směrovač, 
klikneme pravým tlačítkem a vybere položku Set Name, kde nastavíme hodnotu Name dle obr. 1.5. 
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I Hf] Proj ect: EIGRP_vs_I •G P Seena noc •GRP [Subnet top.Enterprise Network] . | n | x | 
File Edit View Scenarios Topology Traffic Protocols Simulation Results Windows Help 

% S 
ZOOM 

ß 
UHIOOM 

ß u 

Obr. 1.5: Vytvoření a pojmenování kruhových topologií 

19. Z palety objektů nyní vybereme 6 objektů typu 100BaseT_LAN (Local Area Network) a umístíme je 
na plochu. Je mnohem vhodnější vkládat na plochu jeden objekt představující více klientů najednou 
než li vkládat jednotlivé klienty a každý ručně nastavovat. 

20. Nakonfigurujeme všechny skupiny klientů. Označíme si levým tlačítkem jednu skupinu klientů a pak 
pravým tlačítkem vybereme položku Select Similar Nodes. Automaticky se nám označí i zbývající 
skupiny klientů. 

21. Znovu klikneme pravým tlačítkem na teď už kteroukoliv skupinu klientů a vybereme položku Edit 
Attributes. Zaškrtneme možnost Apply Changes to Selected Nodes. Nastavíme hodnotu pro počet 
klientů v jednotlivých skupinách klientů následovně: 

Number of Workstations: 500 

Potvrdíme kliknutím na OK. 

22. Dále vybereme z palety objektů: 
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• 2 objekty (pracovní stanice) typu: 
• 6 objektů (skupinu staníc) typu: 
• 8 objektů (přepínačů) typu: 
• 3 objekty (přepínače) typu: 
• 3 objekty (servre) typu: 
• 1 objekt typu: 
• 1 objekt typu: 

ethernet_wkstn (ETH) 
100BaseT LAN 
eth6_ethch6_fddi6_tr6_switch 
ethernet4_layer4_switch 
ethernetserver 
Application Config 
Profile Config 

Nyní jsme ukončili vkladaní 

23. V dalším kroku tyto prvky propojíme a pojmenujeme podle obr. 1.6. 
Jednotlivé linky budou vytvořeny s následující konvencí: 
• 100BaseT 

o mezi přepínačem "eth6_ethch6_fddi6_tr6_switch" a skupinou klientů 
100BaseT LAN" 

o mezi přepínačem "eth6_ethch6_fddi6_tr6_switch" a pracovní stanicí "ethernetwkstn" 
o přepínačem "eth6_ethch6_fddi6_tr6_switch" a směrovačem 

"CS_7204_4s_al_e8_fl_sl8" 
• lOOOBaseX 

o mezi serverem "ethernetserver" a přepínačem "ethernet4_layer4_switch" 
o mezi přepínačem "ethernet4_layer4_switch" a směrovačem 

"CS_7204_4s_al_e8_fl_sl8" 
• PPP-E3 (PPP) point-to-point 

o mezi "STAB" směrovací S T A B 1 - S T A B 2 a S T A B 2 - S T A B 3 
"CS_7204_4s_al_e8_fl_sl8" 

• PPP-E1 
o mezi "STAB" směrovací STAB 1-STAB3 "CS 7204 4s al e8 fl s!8" 

Tím končí naše vkládání všech potřebných zařízení pro výstavbu sítě a následuje jejich konfigurace. 
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1.4 Konfigurace sítě 

Tenhle krok představuje nakonfigurování směrovačů, serverů, hostů a simulačních profilů tak, aby byla 
zabezpečena komunikace v celé síti. 

Tato část pokrývá: 
• generování IP adres 
• rozdělení do autonomních systémů 
• konfiguraci protokolu EIGRP 
• konfiguraci protokolu BGP 

24. Nyní si automaticky vygenerujeme potřebné IP adresy všech L3 (layer 3) rozhraních na směrovacích a 
hostech, které budou použity při směrování. V hlavním menu vybereme Protocols > IP > Addressing 
> Auto-Assign IP Addresses. 
Vším síťovým rozhraním byly takhle přirazeny nezbytné IP adresy pro jednoznačnou identifikaci 
v dané síti. 

25. V následujících několika krocích si zobrazíme výpis všech nově přidělených IP adres. A jak tomu 
napovídá název scénáře "EIGRP", zadefinujeme si také protokol EIGRP pro celou naši síť. V hlavním 
menu vybereme Protocols > IP > Routing > Configure Routing Protocols..., viz obr. 1.7. 
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-*-| Routing Protocol Configuration 

Choose from the following routing protocols. 
This operation will overwrite the existing 
configuration on selected IP interfaces. 

I - None r o s p F 

r~ RIP r is-is 
r~ jGRP W EIGRP 

\7 Apply the above selection to subinterfaces 

• Apply the above selection to: 

C* All interfaces including loopback) 

C Interfaces across selected links 

| 7 Visualize Routing Domains 

Cancel OK 

Obr. 1.7: Výběr směrovacího protokolu EIGRP 

26. A teď nám ještě zbývá zadefinovat simulační parametry pro první velmi jednoduchou simulaci, 
výsledkem které bude pouze možnost zobrazení IP adres. Klikneme v hlavním menu na ikonu 
configure/run simulation, viz obr. 1.9. 
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ZOOM UNZOOl 

ß ß Iconfigure/run simulation 

Obr. 1.9: Výběr směrovacího protokolu EIGRP 

27. V konfiguračním okně, viz obr. 1.10, zadáme v záložce Common hodnotu 10 minut pro trvání 
simulace: 

• Duration: 10 minutes 

A v záložce Global Attributes upravíme následovně tyto 3 parametry: 

• EIGRP Sim Efficiency: 
• IP Interface Addressing Mode: 
• IP Routing Table Export/Import: 

Disabled 
Auto Addressed/Export 
Export 

l i r e S i m u l a t i o n : t l G RP_vs_BG P - EKi RP 

Common Global .Attributes | Object .Attributes | Reports | ü LAs | .Animation | Profiling | Advanced | Environment Files | 

Duration: i : 
Seed: 

Values per statistic: 

12E 
Common | Global Attributes Object Attributes | Reports | S ••: j Animation j Pre 

Update interval: 

\7 Enable simulation log 

Events Attribute ,'alue 

ARP Sim Efficiency Enabled 
ATM SSCOP Sim Efficiency Mode Enabled 
ATM Sim Efficiency Disabled 

ATM VC Routes Export Do Not Export 

BGP Sim Efficiency Mode Enabled 

Background Traffic Start Delay 15C 
CSPF Retry Timer |45 

Custom Application Tracing Do Not Export 

EIGRP Metric Component Specification File eiarp metric compute support 

| EIGRP Sim Efficiency Disabled 

EIGRP Stop Time 365 
FDD I Hop Propagation Delay 3.3E-DS 

FDD I Spawn Station Offset r_ 

FDD I Station Latency |1E-07 
FDD I Transmission Efficiency Disabled 

IGMP Sim Efficiency Enabled 
IGRP Metric Component Specification File igrp_metric_compute_support 

IGRP Sim Efficiency Enabled 

IGRP Stop Time 3S5 
IP Dynamic Routing Protocol Default 

IP Interface Addressing Mode Auto Addressed/Export 

IP Routing Table Export/Import Exc-:'"-

Run Help Cancel OK 

Obr. 1.10: Konfigurace první jednoduché simulace s EIGRP 
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28. Spustíme simulaci kliknutím na tlačítko Run a jakmile se po pár sekundách simulace ukončí, tak 
potvrdíme tlačítkem Close. Prozatím nás ještě výsledky nezajímají, protože nám ke správnému 
fungování protokolu EIGRP chybějí další parametry. Důležité je, že máme teď k dispozici přehledný 
výpis IP adres. Dostaneme se k nim v následujícím kroku. 

29. V hlavním menu vybereme File > Model Files > Refresh Model Directories čím nám IT GURU 
umožňuje sledovat a aktualizovat modelové struktury a pak znova vybereme File > Open, namísto 
Projektu zvolíme Generic Data File a vybereme soubor s postfixem ip_addresses, což je v našem 
případě soubor s názvem "EIGRPvsBGP-noBGP-ipaddresses", viz obr. 1.11, a potvrdíme OK. 

_Jn]2<] 

(Generic Data File 

Project 
Application Characterization 

Generic Date File 
Icon Database 

ace_c 
aceji i 
ati_ge 
atrn_p-
atrn_p 
atm_s 
device_creator_irnport 
device_creator_vendor_icon_rnap 
devicejnap 
eigrp_rnetric_compute_support 

Probe Model 
Analysis Configuration 

EIGRP vs BGP-no BGP-ip addresses 

EIGRP_vs_BG P-no_BG Pip_routes 
E IG R P_«s_BG P-no_BG P-stp_inf o 

|fr_pvc_config 

igrp_rnetric_compute_support 

Cancel 

J 

OK 

Obr. 1.11: Výběr souboru obsahujícího IP adresy použitých rozhraní 

30. Nově otevřené okno zobrazuje detailní výpis všech použitých síťových rozhraní na směrovacích a 
hostech, jejich IP adresy a popis linek, se kterými jsou propojeny. Obr. 1.12 zobrazuje pouze rozhraní 
na směrovacích, které budeme později potřebovat pro konfiguraci protokolu BGP. 
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[Node Name: E n t e r p r i s e N e t w o r k . 5 T A E _ l 
ITace Name ITace i n a e x IP Address subne t Mask <_onnected L i n k 

I F l 1 1 9 2 . 0 . 1 . 1 255 , . 2 5 5 . 2 5 5 . , 0 E n t e r p r i s e N e t w o r k . d u p l e x _ 0 
IF2 2 1 9 2 . 0 . 3 . 1 255 , . 2 5 5 . 2 5 5 . , 0 E n t e r p r i s e N e t w o r k . d u p l e x _ 2 
I F 10 10 1 9 2 . 0 . 2 1 . 1 255 , . 2 5 5 . 2 5 5 . , 0 E n t e r p r i s e Network .STAB_1 <-> STAB_3 
I F l l l i 1 9 2 . 0 . 2 2 . 1 255 . . 2 5 5 . 2 5 5 . . 0 E n t e r p r i s e Network .STAB_1 <-> STAB_2 
Loopback 18 1 9 2 . 0 . 2 4 . 1 255 . . 2 5 5 . 2 5 5 . . 0 Not c o n n e c t e d t o any l i n k . 

Node Name: E n t e r p r i s e N e t w o r k . R o u t e r . 11 1 
ITace Name ITace I ndex IP Address Subnet Mask c o n n e c t e d L i nk 
I F l 1 1 9 2 . 0 . 1 . 2 255 . . 2 5 5 . 2 5 5 . . 0 E n t e r p r i s e N e t w o r k . d u p l e x _ o 
IF2 2 1 9 2 . 0 . 2 . 1 255 , . 2 5 5 . 2 5 5 . , 0 E n t e r p r i s e N e t w o r k . d u p l e x _ l 
IF3 3 192 . 0 . 10 . 1 255 , . 2 5 5 . 2 5 5 . , 0 E n t e r p r i s e N e t w o r k . s w _ l l _ A <-•> R o u t e r . 11 
IF4 4 192 . 0 . 17 . 1 255 , . 2 5 5 . 2 5 5 . , 0 E n t e r p r i s e Network.SW_11_B <-> R o u t e r . _11 
Loopback 18 1 9 2 . 0 . 2 5 . 1 255 , . 2 5 5 . 2 5 5 . , 0 Not c o n n e c t e d t o any l i n k . 

Node Name: E n t e r p r i s e N e t w o r k . R o u t e r . 12 1 
ITace Name ITace i n a e x IP Address subne t Mask <_onnected L i n k 
I F l 1 1 9 2 . 0 . 2 . 2 255 , . 2 5 5 . 2 5 5 . , 0 E n t e r p r i s e N e t w o r k . d u p l e x _ l 
IF2 2 1 9 2 . 0 . 3 . 2 255 , . 2 5 5 . 2 5 5 . , 0 E n t e r p r i s e N e t w o r k . d u p l e x _ 2 
IF3 3 1 9 2 . 0 . 2 0 . 1 255 , . 2 5 5 . 2 5 5 . , 0 E n t e r p r i s e Network.SW_12_A <-> R o u t e r . _12 
Loopback 18 1 9 2 . 0 . 2 6 . 1 255 . . 2 5 5 . 2 5 5 . . 0 Not c o n n e c t e d t o any l i n k . 

Node Name: E n t e r p r i s e Network.STAB 2 1 
ITace Name ITace I ndex IP Address Subnet Mask Connec ted L i n k 

I F l 1 1 9 2 . 0 . 4 . 1 255 . . 2 5 5 . 2 5 5 . . 0 E n t e r p r i s e N e t w o r k . d u p l ex_3 
IF2 2 1 9 2 . 0 . 6 . 1 255 . . 2 5 5 . 2 5 5 . . 0 E n t e r p r i s e N e t w o r k . d u p l e x _ 5 
IF10 10 1 9 2 . 0 . 2 2 . 2 255 , . 2 5 5 . 2 5 5 . , 0 E n t e r p r i s e Ne two rk .STAB_ l <-> STAB 2 
I F l l 11 1 9 2 . 0 . 2 3 . 1 255 , . 2 5 5 . 2 5 5 . , 0 E n t e r p r i s e Network.STAB_2 <-> STAB_3 
Loopback 18 1 9 2 . 0 . 2 7 . 1 255 , . 2 5 5 . 2 5 5 . , 0 Not c o n n e c t e d t o any l i n k . 

Node Name: E n t e r p r i s e N e t w o r k . R o u t e r . _2 2 1 
IPdLt l NdJIlt! I r d L t ! INUtlX IP AUUr'tÜjb SULNtlL Nidi K LuriritiLLtiu Link 

I F l 1 1 9 2 . 0 . 4 . 2 255 , . 2 5 5 . 2 5 5 . , 0 E n t e r p r i s e N e t w o r k . d u p l ex_3 
IF2 2 1 9 2 . 0 . 5 . 1 255 , . 2 5 5 . 2 5 5 . , 0 E n t e r p r i s e N e t w o r k . d u p l ex_4 
IF3 3 192 . 0 . 13 . 1 255 , . 2 5 5 . 2 5 5 . , 0 E n t e r p r i s e Network.SW_2 2_A <-> R o u t e r . _2 2 
IF4 4 192 . 0 . 14 . 1 255 . . 2 5 5 . 2 5 5 . . 0 E n t e r p r i s e Network.SW_2 2_B <-> R o u t e r . _2 2 
Loopback 18 1 9 2 . 0 . 2 8 . 1 255 . . 2 5 5 . 2 5 5 . . 0 Not c o n n e c t e d t o any l i n k . 

Node Name: E n t e r p r i s e N e t w o r k . R o u t e r . 21 1 
ITace Name ITace I ndex IP Address Subnet Mask c o n n e c t e d L i n k 
I F l 1 1 9 2 . 0 . 5 . 2 255 . . 2 5 5 . 2 5 5 . . 0 E n t e r p r i s e N e t w o r k . d u p l ex_4 
IF2 2 1 9 2 . 0 . 6 . 2 255 , . 2 5 5 . 2 5 5 . , 0 E n t e r p r i s e N e t w o r k . d u p l e x _ 5 
IF3 3 192 . 0 . 12 . 1 255 , . 2 5 5 . 2 5 5 . , 0 E n t e r p r i s e N e t w o r k . s w _ 2 l _ A <-•> R o u t e r . 21 
IF4 4 192 . 0 . 19 . 1 255 , . 2 5 5 . 2 5 5 . , 0 E n t e r p r i s e Network.SW_21_B <-> R o u t e r . _21 
Loopback 18 1 9 2 . 0 . 2 9 . 1 255 , . 2 5 5 . 2 5 5 . , 0 Not c o n n e c t e d t o any l i n k . 

Node Name: E n t e r p r i s e N e t w o r k . R o u t e r . _31 1 
ITaCe NSffle IP Aaaress Subnet MaSk (.snnarraa Link 

I F l I 1 9 2 . 0 . 7 . 1 255 , . 2 5 5 . 2 5 5 . , 0 E n t e r p r i s e N e t w o r k . d u p l e x _ 6 
IF2 2 1 9 2 . 0 . 9 . 1 255 , . 2 5 5 . 2 5 5 . , 0 E n t e r p r i s e N e t w o r k . d u p l e x _ 8 
IF3 3 192 . 0 . 1 1 . 1 255 , . 2 5 5 . 2 5 5 . , 0 E n t e r p r i s e Network.SW_31_B <-> R o u t e r . _31 
IF4 4 192 . 0 . 18 . 1 255 . . 2 5 5 . 2 5 5 . . 0 E n t e r p r i s e Network.SW_31_A <-> R o u t e r . _31 
Loopback 18 1 9 2 . 0 . 3 0 . 1 255 , . 2 5 5 . 2 5 5 . , 0 Not c o n n e c t e d t o any l i n k . 

Node Name: E n t e r p r i s e N e t w o r k . R o u t e r . _3 2 1 
ITaCe Naffle i r a t e lUBex1 IP Aflfll"e55 SuBHet Mask connecTea Link 

I F l 1 1 9 2 . 0 . 7 . 2 255 . . 2 5 5 . 2 5 5 . . 0 E n t e r p r i s e N e t w o r k . d u p l e x _ 6 
IF2 2 1 9 2 . 0 . 8 . 1 255 , . 2 5 5 . 2 5 5 . , 0 E n t e r p r i s e N e t w o r k . d u p l e x _ 7 
IF3 3 1 9 2 . 0 . 1 5 . 1 255 , . 2 5 5 . 2 5 5 . , 0 E n t e r p r i s e Network.SW_3 2_A <-> R o u t e r . 32 
IF4 4 192 . 0 . 16 . 1 255 , . 2 5 5 . 2 5 5 . , 0 E n t e r p r i s e Network.SW_3 2_B <-> R o u t e r . _3 2 
Loopback 18 1 9 2 . 0 . 3 1 . 1 255 , . 2 5 5 . 2 5 5 . , 0 Not c o n n e c t e d t o any l i n k . 

Node Name: E n t e r p r i s e Network.STAB_3 1 
I T a f e Naffle I T a f e lUfleW IP AflflreS! subne t Mask Lorl I lecTea Llllk 

I F l 1 1 9 2 . 0 . 8 . 2 255 , . 2 5 5 . 2 5 5 . , 0 E n t e r p r i s e N e t w o r k . d u p l e x _ 7 
IF2 2 1 9 2 . 0 . 9 . 2 255 , . 2 5 5 . 2 5 5 . , 0 E n t e r p r i s e N e t w o r k . d u p l e x _ 8 
IF10 10 1 9 2 . 0 . 2 1 . 2 255 , . 2 5 5 . 2 5 5 . , 0 E n t e r p r i s e Network .STAB_1 <-> STAB_3 
I F l l 11 1 9 2 . 0 . 2 3 . 2 255 , . 2 5 5 . 2 5 5 . , 0 E n t e r p r i s e Network.STAB_2 <-> STAB_3 
Loopback 18 1 9 2 . 0 . 3 2 . 1 255 . . 2 5 5 . 2 5 5 . . 0 Not c o n n e c t e d t o any l i n k . 

Obr. 1.12: Výpis IP adres rozhraní na směrovacích 

Poznámka: 
Automaticky vygenerované IP adresy pro příslušné rozhraní na směrovací se mohou v IT GURU lišit 
od projektu k projektu v závislosti, které linky a v jakém pořadí byly vytvořeny. 
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31. Nyní si nastavíme nezbytné profily pro modelování komunikace v síti. Začneme s profilem 
Application Config, který jsme pojmenovali "Applications". Označíme tenhle objekt na ploše a 
pravým tlačítkem si z kontextového menu zvolíme Edit Attributes. U položky Application 
Definitions zvolíme hodnotu Default, která nám zajistí vytvoření 16-ti předdefinovaných aplikací, 
jako např.: 

• Database Access 
• File Transfer 
• Telnet Session 
• 

Poté klikneme na tlačítko OK a tím končí naše nastavení objektu Application Config. 

32. Pro definici profilů na všech použitých aplikací se používá objekt Profile Config, který jsme si 
pojmenovali "Profiles". Ten nám bude udávat, kdy se jaká aplikace bude spouštět, kolikrát se v síti 
bude moci opakovat a pod. Označíme si tenhle objekt na ploše a následovně budeme editovat: 
Hodnotu atributu Profile Configuration změníme na Edit a v nově zobrazené tabulce nastavíme 
položku Rows z 0 na 1 a dále ještě nastavíme tyto hodnoty, viz obr. 1.13: 

• Profile Name: 
• Operation Mode: 
• Start Time (seconds): 

L A N Client 
Simultaneous 
Distribution Name: 
Mean Outcome: 

constant 
100 

-*-| [Profile Configuration} Table Jo]*] 
applications 

Í5 5ie Rows _ 

Simultaneous 
3 

ind of Simulation Once at Start Time 

-<k\ "StartTime" Specification 

Cancel 

Distribution Name: 

Second Argument: 

Obr. 1.13: Definice profilu 

Potvrdíme dvakrát OK. Takhle budou všechny aplikace začínat ve stejný čas a každá aplikace bude 
spouštěna ve 100 sekundách od zahájení simulace. 

33. Nyní máme nastavený profil, ale ještě konfiguraci profilu neopustíme, protože musíme ještě v položce 
Applications, která se nachází pod Profile Configuration, rows 0, zadat, jaké konkrétní aplikace a 
především s jakou konkrétní zátěží se v tomto profilu budou spouštět. My budeme používat následující 
3 aplikace, viz obr. 1.14: 

• row: 3 

• Name: Database Access (Heavy) 
• Distribution Name: uniform 
• Minimum outcome: 0 
• Maximum outcome: 300 
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Name: 
Distribution Name: 
Minimum outcome: 
Maximum outcome: 

File Transfer (Heavy) 
uniform 
0 
300 

Name: 
Distribution Name: 
Minimum outcome: 
Maximum outcome: 

Telnet Session (Heavy) 
uniform 
0 
300 

HtJ (Profiles) At t r ibu tes 

Type:[ 'Jt :es 

lži 

" 3 I attribute 
® r-name 
(J) \- model 
® p ] Drofile Configuration 
#| |-rowa 

PI row 0 
(J) |-Profile Name 
© [+] Applications 
® |-Operation Mode 
(?) |—-Start Time [seconds] 
^ | |- Duration (seconds] 
(J) \+\ Repeatability 

-•^ (Ap p [Ratio its) Table 

|Value 
I Profiles  
Profile Config 

I L L 

LAN Client 

Simultaneous 
constant \)ZZ] 
End of Simulation 
Once at Start Time 

jn|xj 

Name | Start Time Offset (se.. | Duration [seconds) j Repeatability 

File Transfer (Heavy) uniform [D, 3DD) End of Profile 1 Unlimited 
Database .Access (H... uniform [D, 3DD) End of Profile 1 Unlimited 
Telnet Session [Heavy) uniform [D. SDD) End of Profile Unlimited 

Details 

Rows 

Promote Cancel 0< 

Cancel OK 

Obr. 1.14: Nastavení spouštění aplikací 

Potvrdíme dvakrát OK. Konfigurace aplikací je tak hotová. 

34. Nyní už jen stejně nastavíme jednotlivé sítě L A N . Levým tlačítkem si na ploše označíme jeden 
libovolný objekt typu 100BaseT_LAN a pak pravým tlačítkem vybereme položku Select Similar 
Nodes. Automaticky se nám označí i zbývajících 6 L A N objektů, pro které při editaci atributu 
Application Supported Profiles nastavíme rows na hodnotu 1 a následovně vyplníme tyto parametry, 
viz obr. 1.15: 

• Profile Name: L A N Client 
• Number of Clients: Entire L A N 
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- ^ (App l i ca t ion : Supported Profiles) Table 

I Number of Clients 

I Entire LAN 

1 insert 

Details Promete 

Obr. 1.15: Nastavení spouštění profilů 

Zaškrtneme možnost Apply Changes to Selected Nodes a potvrdíme dvakrát tlačítkem OK. 
Dostáváme tak nadefinovány jednotlivé skupiny po 15-ti klientech. 

35. Nastavíme si vyexportování atributů směrovacích tabulek na všech dostupných směrovacích. Levým 
tlačítkem si na ploše označíme jeden libovolný směrovač a pak pravým tlačítkem vybereme položku 
Select Similar Nodes. Automaticky se nám označí i zbývající směrovače. V hlavním menu si teď 
vybereme Protocols > IP > Routing > Export Routing Table for Selected Routers a informaci 
v nově otevřeném okně o exportu směrovacích tabulek pro zvolené směrovače potvrdíme tlačítkem 
OK 

36. Nyní spustíme simulaci EIGRP protokolu ještě jednou (viz krok 28) a to už jen pomocí tlačítka Run. 

37. Jakmile simulace skončí, což potrvá několik vteřin, aktivuje se nám tlačítko Close, na které klikneme a 
opustíme tak simulační okno. 

38. Prozkoumáme teď jednotlivé směrovací tabulky pro směrování protokolem EIGRP. Z hlavního menu 
vybereme Results > Open Simulation Log, viz obr. 1.16. 

4řJLog Browser - [QGRP_vs_BGP-EIGRP 

Simulation Log [EIGRP_^ 
Categories 

Results 
Comfig. 

Classes 
EIGRP 

Performance 1 
Event Manager 

Performance | 
IP 

^jnjxj 

3 Time 
SZZ 
s:: 
i\\ 
í:: 
s:: 
í:: 
; : : 
600 
s:: 

k J 

j Event 
10915732 

110919734 
1C513ľ^ 

110919733 
Y.lM~-2 

1091973C 
1091572G 
1091574G 

|Node 
Enterprise 
Enterprise 
Enterprise 
Enterprise 
Enterprise 
Enterprise 
Enterprise 
Enterprise 
Enterprise 

Network 
Network 
Network 
Network 
Network 
Network 
Network 
Network 
Network 

RouterJ 1 
Router_12 
Router_21 
Router_22 
Router_31 
Router_32 
STABJ 
3T.-.B_2 
STAB 3 

| Category 
Results 
Results 
Results 
Results 
Results 
Results 
Results 
Results 
Results 

Select columns to display in Subclass view 

|7 Time |7 Event | 7 Node 

| 7 Category \~ Gass I - Subclass 

Message 
COMMON ROUTE TABLE snapshot for: I (...) 
:OMMON ROUTE TABLE snapshot for: L.) 
: 0 7 7 0 \ ROUTE T-E_E?-aos-=:^r: 
COMMON ROUTE TABLE snapshot for: (...J 
COMMON ROUTE TABLE snapshot for: (...) 
COMMON ROUTE TABLE snapshot for: (...) 

MM0N ROUTE TABLE snaoshot for: • 
COMMON ROUTE TABLE snapshot for: I (...) 
COMMON ROUTE TABLE snapshot for: (...) 

Obr. 1.16: Směrovací tabulky směrovačů s protokolem EIGRP 
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39. Levým tlačítkem klikneme na jednotlivé směrovače a přesvědčíme se tak, jestli každá směrovací 
tabulka obsahuje všechny cesty do okolních sítí. Na obr. 1.17 je zobrazena směrovací tabulka 
směrovače "STAB 1". 

HíJLog Entry 3 
File Edit Options 

Id*] 

3 C m 

11 COMMON ROUTE TABLE snapshot for: 
Router name: Enterprise N e two rk\ 5TAB_l*| 

at time: 3 5 3 , £ 6 seconds 

IROUTE TABLE contents 

•est. Address subnet Mask Next Hop interface Name insert i on Time 

L i — I 

NOTE: In order to view the individual routing tables maintained 
by various dynamic routing protocols [e.g., OSPF and RIP}, you 
can set the simulation attribute "IP Routing Table Export/import" 
to "Export" to generate a network-wide routing table/protocol output. 

11 132 0 1.0 255 255 255 . 0 192 0 1. 1 IF1 •:• Direct 0 000 
12 132 0 3 . 0 255 255 255 . 0 192 0 3 . 1 IF2 0 Direct 0 000 
13 192 0 21.0 255 255 255 . 0 192 0 21 . 1 IF10 0 Direct 0 000 
14 192 0 22.0 255 255 255 . 0 192 0 22 . 1 IF11 0 Direct 0 000 
15 192 0 24.0 255 255 255 . 0 192 0 24 . 1 Loopback 0 Direct 0 000 
16 192 0 2 . 0 255 255 255 . 0 192 0 1. 2 IF1 7680 EIGRP 5 001 
17 192 0 3. 2 IF2 7680 EIGRP 5 001 
11 192 0 10.0 255 255 255 . 0 192 0 1. 2 IF1 30720 EIGRP 5 001 
13 192 0 17.0 255 255 255 . 0 192 0 1. 2 IF1 7680 EIGRP 5 001 
20 192 0 25.0 255 255 255 . 0 192 0 1. 2 IF1 133120 EIGRP 5 001 
71 192 0 20.0 255 255 255 . 0 192 0 3 . 2 IF2 30720 EIGRP 5 001 
22 192 0 26.0 255 255 255 . 0 192 0 3 . 2 IF2 133120 EIGRP 5 001 
23 192 0 4.0 255 255 255 . 0 192 0 22 . 2 IF11 92928 EIGRP 5 001 
24 192 0 6.0 255 255 255 . 0 192 0 22 . 2 IF11 92928 EIGRP 5 001 
25 192 0 23.0 255 255 255 . 0 192 0 22 . 2 IF11 106496 EIGRP 5 001 
7Ě 192 0 27.0 255 255 255 . 0 192 0 22 . 2 IF11 218368 EIGRP 5 001 
27 192 0 5 . 0 255 255 255 . 0 192 0 22 . 2 IF11 95488 EIGRP 5 001 
2B 192 0 12.0 255 255 255 . 0 192 0 22 . 2 IF11 95488 EIGRP 5 001 
73 192 0 19.0 255 255 255 . 0 192 0 22 . 2 IF11 95488 EIGRP 5 001 
30 192 0 29.0 255 255 255 . 0 192 0 22 . 2 IF11 220928 EIGRP 5 001 
31 192 0 13 . 0 255 255 255 . 0 192 0 22 . 2 IF11 95488 EIGRP 5 001 
32 192 0 14.0 255 255 255 . 0 192 0 22 . 2 IF11 95488 EIGRP 5 001 
33 192 0 28.0 255 255 255 . 0 192 0 22 . 2 IF11 220928 EIGRP 5 001 
34 192 0 8.0 255 255 255 . 0 192 0 22 . 2 IF11 109056 EIGRP 5 002 
35 192 0 9.0 255 255 255 . 0 192 0 22 . 2 IF11 109056 EIGRP 5 002 
3Ě 192 0 32.0 255 255 255 . 0 192 0 22 . 2 IF11 234496 EIGRP 5 002 
37 192 0 7.0 255 255 255 . 0 192 0 22 . 2 IF11 111616 EIGRP 5 002 
3B 192 0 15.0 255 255 255 . 0 192 0 22 . 2 IF11 111616 EIGRP 5 002 
30 192 0 16.0 255 255 255 . 0 192 0 22 . 2 IF11 111616 EIGRP 5 002 
40 192 0 31.0 255 255 255 . 0 192 0 22 . 2 IF11 237056 EIGRP 5 002 
41 192 0 11.0 255 255 255 . 0 192 0 22 . 2 IF11 111616 EIGRP 5 002 
47 192 0 18.0 255 255 255 . 0 192 0 22 . 2 IF11 111616 EIGRP 5 002 
43 192 0 30.0 255 255 255 . 0 192 0 22 . 2 IF11 237056 EIGRP 5 002 

45 The gateway of last resort i 5 not set 

I Line: 1 

Obr. 1.17: Směrovací tabulka směrovače "STAB_1" pro EIGRP 

1.4.1 Vytvoření nového scénáře a konfigurace BGP protokolu 

V tomhle kroku si v nově vytvořeném scénáři nakonfigurujeme 3 autonomní systémy a směrování mezi 
nimi bude zabezpečovat mezi-doménový protokol BGP, který bude nést vnitřně-doménový protokol 
EIGRP - už nakonfigurovaný v předešlých krocích. 

V téhle části se věnujeme: 
• vytvoření dalšího scénáře 
• vytvoření 3 odlišných autonomních systémů 
• konfiguraci protokolu BGP 

40. Z hlavního menu vybereme Scenarios > Duplicate Scenario... a zvolíme jméno nového scénáře 
"withBGP", následně potvrdíme tlačítkem OK. 
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41. Nyní si zadefinujeme kombinaci směrovacích parametrů současně pro oba protokoly: EIGRP a BGP. 
Levým tlačítkem si na ploše označíme jeden libovolný směrovač a pak pravým tlačítkem vybereme 
položku Select Similar Nodes. Automaticky se nám označí i zbývající směrovače. 

42. Pravým tlačítkem klikneme na kterýkoliv označený směrovač a vybereme položku Edit Attributes. 
Zaškrtneme možnost Apply Changes to Selected Nodes. Nastavíme následující směrovací parametry 
[4]: 

a) Oznamování protokolu EIGRP protokolem BGP 
BGP Parameters —> Redistribution —> Routing Protocols —> EIGRP —> Redistribute w/ 
Default 

b) Exportování směrovací tabulky pouze na konci simulace 
IP Routing Parameters —> Routing Table Export —> Export Time(s) Specification —> 
Once at End of Simulation 

c) Oznamování přímo připojených sítí protokolem EIGRP 
EIGRP Parameters —> AS Parameters —> rows 0 —> Process Parameters —> 
Redistribution —> Routing Protocols —> Directly Connected —> Redistribute w/ Default 

Potvrdíme tlačítkem OK. 

V naší síti se nyní všechny směrovače nachází ve stejném autonomním systému. Rozdělíme tedy celou 
naši síť do 3 odlišných autonomních systémů a použijeme právě protokol BGP pro směrování paketů 
mezi nimi navzájem. 

43. Označíme si první skupinu směrovačů, které budou tvořit první autonomní systém: 
• Routerl 1 
• Router_12 
• S T A B l 

V hlavním menu vybereme Protocols > IP > Addressing > Configure AS Number for Selected 
Routers..., viz obr. 1.18. 

Obr. 1.18: Konfigurování prvního Autonomního systému 

V dialogovém okně zadáme hodnotu 65100 a potvrdíme tlačítkem OK. Určili jsme tak konkrétní 
skupinu směrov ačů a číslo pro první autonomní systém. 
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44. Zopakujeme podobný postup pro druhou skupinu směrovaču s následujícími parametry: 

• Router_21 
• Router_22 
• STAB 2 

Číslo druhého autonomního systému bude 65200. 

45. A ještě zopakujeme podobný postup pro třetí skupinu směrovaču s následujícími parametry: 
• Router_31 
• Router_32 
• STAB 3 

Číslo třetího autonomního systému bude 65300. 

V následujících několika krocích zakážeme činnost protokolu EIGRP mezi autonomními systémy. 
Směrování tedy bude probíhat výlučně protokolem BGP. Jedná se konkrétně o tři PPP linky mezi 
S T A B x směrovací. 

Když najedeme kurzorem na mapě na příslušnou linku, zobrazí se nám okamžitá informace o portech, 
na kterých je linka na příslušném směrovací ukončena. 
V našem případě by mělo toto ukončení vypadat takto: 

Linka S T A B l - S T A B 2 
• S T A B l , ifll 
• S T A B 2 , iflO 

Linka S T A B 2 - S T A B 3 
• S T A B 2 , ifll 
• S T A B 3 , ifll 

Linka S T A B l - S T A B 3 
• S T A B l , iflO 
• S T A B 3 , iflO 

46. Klikneme pravým tlačítkem na směrovač STAB_1 a vybereme položku Edit Attributes. Podle [4] 
zakážeme nyní fungování protokolu EIGRP na následujících dvou portech: 
IP Routing Parameters —> Interface Information —> rows 10 (if 10) —> Routing Protocol(s) —> 
disable EIGRP, viz obr. 1.19 
IP Routing Parameters —> Interface Information —> rows 11 (if 11) —> Routing Protocol(s) —* 
disable EIGRP 
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H í j ( S T A B _ l ) A t t r i b u t e s 

Type: [ routei Make: Cisco 7204 

Attribute 

E+]row 9 
R r o w l O 

|-Narne 
[—Status 
| - Address 

|-Subnet Mask 

EE]SecondariJ Address Information 
H-l S ubintertace Information 

Value 

\1S 

IFS^Active^Auto AssignedAuto Assigned,Not Us.. 

IF10 
Active 

192.0.21.1 
255.255.255.0 

Not Used 
None 

\-Routing Protocols] 
| -MTU [bytes) 

f£]Metric Intormation 
f+]QoS Information 

|—Multicast Mode  
r+1 Layer 2 Mappings 
[ J j Packet Filter 

|— Policy Routing 
| -VRFName 

[-Compression Intormation  
L- Description 

[+] row 11 
EB row 12 
EE] row 13 
r + l r o w 1 4 ^ ^ 

hanges to Selected Objects 

EIGRP 

j ^ J Se lec t D y n a m i c R o u t i n g P ro toco l s 2Si 

Routing Protocol Status d 
w~ Disabled 
IGRP Disabled 
OSPF Disabled 

EIGRP Disabled |j 

IS -IS Disabled 

d 

Routing Pn 

RIP 
BlGRP 
BoSPF 

I EIGRP 

I 

Cancel 

I - Advanced 

OK 

Obr. 1.19: Zákaz šíření protokolu EIGRP do AS 

Potvrdíme dvakrát tlačítkem OK. 

47. Zopakujeme krok 46 dle výše uvedených informací také i pro směrovače STAB_2 a STAB_3. 

Nyní podle [5] přichází na řadu definice sousedních směrovačů. Jednotliví "sousedé" jsou definováni 
IP adresou a číslem AS. Při následující detailní konfiguraci bude nezbytné znát IP adresy všech 
použitých portů na všech směrovacích tak, jak je to uvedeno v krocích 29 a 30 resp. na obr. 1.12. 

Pro definici protokolu BGP je nutné nakonfigurovat všech 9 směrovačů v síti. Ukážeme si pouze 
konfiguraci směrovačů Router_ll, který má pouza dva sousední směrovače, a směrovače STAB_1, 
který má čtyři sousední směrovače, přičemž ostatní směrovače se budou konfigurovat analogicky 
podle těchtou dvou. 

48. Označíme si na mapě směrovač Router_ll. Klikneme na něj pravým tlačítkem a vybereme položku 
Edit Attributes. Otevřeme tabulku sousedních směrovačů protokolu BGP přes: 
BGP Parameters —* Neighbor Information —> (...) 
a v nově otevřeném okně zvýšíme hodnotu Rows z nuly na 2. 

Poznámka: 
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Následující IP adresy odpovídají automatickému vygenerování z kroku 24 pro příslušné rozhraní dle 
obr. 1.12. 

Zadáme následující hodnoty pro dva sousední směrovače, viz obr. 1.20. 
• první sousední směrovač má IP adresu 192.0.1.1 
• druhý sousední směrovač má IP adresu 192.0.2.2 
pro oba směrovače platí stejné číslo AS, a sice 65100 

* ] [ R o i t t e r J 1} A t t r i b u t « 

Type: Make: 

J n j x j 

1 Attribute j Value •* I 
(J) ElBGP Parameters 
(J) |-Status I Enabled 
(J) |- Start Time consta- • 
(J) \+\ Neighbor Information 

-«•| [Neighbor In fo rmat ion ] Table _ |n | x| 

IP Address | Remote AS I EBGP Muttihop Se... j Timers I Next Hop Serf I Updaty. j 
192 D 1.1 S51GC No EEG P Murrihop | (...(' Default Not Ue 
152. E .2.2 651 CD No EBGP Murühop |(...) Ič-=:.t | l \ . 

i t 
j 

<l I i t 
: Rows Move Up Move Down I 

Details Promote Cancel OK I 

find Next Cancel OK 

Obr. 1.20: Definice BGP pro směrovač Router_ l l 

Potvrdíme dvakrát tlačítkem OK. 

49. Označíme si na mapě směrovač STAB_1. Klikneme pravým tlačítkem a vybereme položku Edit 
Attributes. Také otevřeme tabulku sousedních směrovačů protokolu BGP přes: 
BGP Parameters —* Neighbor Information —> (...) 
a v nově otevřeném okně zvýšíme již hodnotu Rows z nuly na 4. 

Poznámka: 
Následující IP adresy odpovídají automatickému vygenerování z bodu 24 pro příslušné rozhraní dle 
obr. 1.12. 

Zadáme následující hodnoty pro čtyři sousední směrovače [5], viz obr. 1.21. 
• první sousední směrovač má IP adresu: 192.0.1.2 
• druhý sousední směrovač má IP adresu: 192.0.3.2 
• třetí sousední směrovač má IP adresu: 192.0.22.2 
• čtvrtý sousední směrovač má IP adresu: 192.0.21.2 
pro první a druhý směrovač platí stejné číslo AS, a sice: AS 65100 
pro třetí směrovač platí číslo: AS 65200 
pro čtvrtý směrovač platí číslo: AS 65300 
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- g ( S T A B _ l ) A t t r i b u t e s 

Type: router Make: c i s ™ ™ * 

" 3 Attribute Value 

© |— Status 1 Enabled 

© |-Start Time | constant [70) 

© \+\Neighbor Information 

© [+1 Timers 

© |— Default Local Preference 1150 
© |-Synchronization 1 Enabled 

© \+\Network Reachability Information B None 

j * J (Ne ighbor I n f o r m a t i o n ) Tab le 

IP Address Remote AS I EBGP Multihop Se...| Timers |Next Hop Self Update S<_±J 

192.0.1.2 65100 |NoEBGPMult ihop |[...) 1 Default 1 Not Used )::( 
192.0.3.2 65100 |No EBGP Multihop |[...) 1 Default Not Used 5 
192.0.22.2 65200 |No EBGP Multihop |(...) 1 Default Not Used Q 
192.0.21.2 65300 |No EBGP Multihop | [„ .) 1 Default 1 Not U s e d l a 

<l • 1 • ľ" 

I Apply Ľhan J Ub|ec 

OK Find Next Cancel 

Obr. 1.21: Definice BGP pro směrovač STAB_1 

Potvrdíme dvakrát tlačítkem OK. 

50. Analogicky dle kroku 48 vytvoříme obdobnou konfiguraci pro směrovače: 
• Router_12 
• Router_21 
• Router_22 
• Router_31 
• Router_32 

51. Analogicky dle kroku 49 vytvoříme obdobnou konfiguraci pro směrovače: 
• S T A B 2 
• S T A B 3 
Nyní máme správně nakonfigurovaný protokol BGP. 

52. V tomhle kroku si na mapě zvýrazníme směrovací protokoly. Označíme si na mapě vnitřně-doménové 
směrovací linky: 
• kruh: Routerll v s Router_12 v s S T A B l 
• kruh: Router_21 vs Router_22 vs STAB2 
• kruh: Router_31 vs Router_32 vs STAB3 
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53. Zopakujeme postup z kroku 25 pro výběr směrovacího protokolu EIGRP na našich 9 označených 
linkách v rámci třech AS a se žádným (none) směrovacím protokolem na třech PPP linkách mezi 
S T A B x směrovací, viz obr. 1.22. 

Obr. 1.22: Směrování pomocí EIGRP a BGP protokolů 

54. Nyní, pro podrobný náhled na směrovací tabulky, spustíme simulaci obou použitých protokolů podle 
bodu 28 a to už jen pomocí tlačítka Run. 

55. Jakmile opět simulace skončí, potrvá to pár vteřin, aktivuje se nám tlačítko Close, na které klikneme a 
opustíme tak simulační okno. 

56. Prozkoumáme teď jednotlivé vyexportované směrovací tabulky pro směrování protokolem EIGRP a 
BGP - obdobně dle bodu 38 máme na obr. 1.23 zobrazenou směrovací tabulku směrovače "STAB 1". 
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^ L o g Entry 3 m •JxJ 

_ 5 ] _ g j J Ě j j ] | ] j B ] > 

SIOMMON ROUTE TABLE snapshot for: 
Router name: Enterprise NetworkJSTAB_1I 

at time: 359,26 seconds 1 1 

ROUTE TABLE contents: 

•est. Address subnet Mask Next Hop interface Name insert i on Time 

11 192 0 1.0 255 255 255 . 0 192 0 1.1 IF1 Ü Direct 0, 000 
12 192 0 3 . 0 255 255 255 . 0 192 0 3 . 1 IF2 0 Direct 0, 000 
13 192 0 24.0 255 255 255 . 0 192 0 24.1 Loopback 0 Di rect 0, 000 
14 192 0 21.0 255 255 255 . 0 192 0 21.1 IF10 0 Direct 0, 000 
15 192 0 22.0 255 255 255 . 0 192 0 22.1 IF11 0 Di rect 0, 000 
lfr 192 0 2 . 0 255 255 255 . 0 192 0 1.2 IF1 7680 EIGRP 5 , 001 
17 192 0 3 . 2 IF2 7680 EIGRP 5 , 001 
IB 192 0 10. 0 255 255 255 . 0 192 0 1.2 IF1 30720 EIGRP 5 , 001 
19 192 0 17. 0 255 255 255 . 0 192 0 1.2 IF1 7680 EIGRP 5 , 001 
20 192 0 25.0 255 255 255 . 0 192 0 1.2 IF1 133120 EIGRP 5 , 001 
21 192 0 20.0 255 255 255 . 0 192 0 3 . 2 IF2 30720 EIGRP 5 , 001 
22 192 0 26. 0 255 255 255 . 0 192 0 3 . 2 IF2 133120 EIGRP 5 , 001 
23 192 0 4.0 255 255 255 . 0 192 0 22.2 IF11 0 EG P 70,002 
24 192 0 6.0 255 255 255 . 0 192 0 22.2 IF11 0 BGP 70,002 
25 192 0 27.0 255 255 255 . 0 192 0 22.2 IF11 0 EG P 70,002 
Zl 192 0 5 . 0 255 255 255 . 0 192 0 22.2 IF11 7680 BGP 70,002 
27 192 0 12 . 0 255 255 255 . 0 192 0 22.2 IF11 30720 BGP 70,002 
23 192 0 19. 0 255 255 255 . 0 192 0 22.2 IF11 7680 BGP 70,002 
29 192 0 29.0 255 255 255 . 0 192 0 22.2 IF11 133120 BGP 70,002 
30 192 0 13 . 0 255 255 255 . 0 192 0 22.2 IF11 30720 BGP 70,002 
31 192 0 14. 0 255 255 255 . 0 192 0 22.2 IF11 30720 BGP 70,002 
32 192 0 28.0 255 255 255 . 0 192 0 22.2 IF11 133120 BGP 70,002 
33 192 0 8.0 255 255 255 . 0 192 0 21.2 IF10 0 BGP 70,003 
34 192 0 23.0 255 255 255 . 0 192 0 22.2 IF11 2588160 BGP 70,003 
35 192 0 9.0 255 255 255 . 0 192 0 21.2 IF10 0 BGP 70,003 
35 192 0 32.0 255 255 255 . 0 192 0 21.2 IF10 0 BGP 70,004 
37 192 0 7.0 255 255 255 . 0 192 0 21.2 IF10 7680 BGP 70,004 
33 192 0 11. 0 255 255 255 . 0 192 0 21.2 IF10 30720 BGP 70,005 
39 192 0 18. 0 255 255 255 . 0 192 0 21.2 IF10 7680 BGP 70,005 
40 192 0 30.0 255 255 255 . 0 192 0 21.2 IF10 133120 BGP 70,005 
41 192 0 15 . 0 255 255 255 . 0 192 0 21.2 IF10 30720 BGP 70,006 
42 192 0 16. 0 255 255 255 . 0 192 0 21.2 IF10 30720 BGP 70,006 
43 192 0 31.0 255 255 255 . 0 192 0 21.2 IF10 133120 BGP 70,006 

45 The gateway of last resort i 5 not set 

INCITE: In order to view the individual routing tables maintained 
by various dynamic routing protocols (e .g . , OSPF and RIP}, you 
can set the simulation attribute "IP Routing Table Export/Import" 
to "Export" to generate a network-wide routing table/protocol output. 

I Line: 1 

Obr. 1.23: Směrovací tabulka směrovače "STAB_1" pro EIGRP a BGP 

1.4.2 Vytvoření nového scénáře s pravidlem pro BGP směrování 

V tomhle kroku si v nově vytvořeném scénáři uplatníme směrovací pravidlo v rámci protokolu BGP, který 
obecně dovoluje uplatnit jedno nebo více směrovacích pravidel pomocí tzv. směrovacích map [3]. Jedno 
takové pravidlo si zadefinujeme na směrovací S T A B 2 pro odlehčení P P P E 3 linky směrem na směrovač 
S T A B 3 do AS 65300. Drtivá většina komunikace v síti určená pro AS 65300 tak bude následně 
směrována přes směrovač S T A B l do směrovaču S T A B 3 - tedy přes 2 přeskoky. 

V téhle části se věnujeme: 
• vytvoření konkrétní směrovací mapy 
• uplatnění směrovacího pravidla BGP protokolu 

57. Z hlavního menu vybereme Scenarios > Duplicate Scenario... a zvolíme jméno nového scénáře 
"wi thBGPPol icy" , a následně potvrdíme tlačítkem OK. 

58. Pravým tlačítkem klikneme na směrovač S T A B 2 a vybereme položku Edit Attributes. 
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59. Nyní si vytvoříme požadovanou směrovací mapu: 
IP Routing Parameters —> Route Map Configuration 

60. Následně si nastavíme její parametry, viz obr. 1.24: 

Map Label 
Match Property 
Match Condition 
Match Value 
Set Attribute 
Set Operation 
Set Value 

Route Map 1 
AS Path 
Contains 
65300 
Local Preference 
Set As 
1 

Hodnota atributu Set Value je nastavena na "1", což znamená pouze jedno-procentní vytížení linky 
protokolem BGP pro směrování do AS 65300. 

Poznámka: 
Nominální hodnota pro maximální vytížení je "100". 
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j j ŕ j ( S T A B _ 2 ) A t t r i b u t e s 

Type: router Make: 

Attribute Value ± . 

(?J n IP Routing Parameters Í...1 

© I-Router ID Auto Assigned 

|-Autonomous System Number G5200 

© [+ ] Interface Information (...) 

© [+1 Loopback Interfaces K - ) 

© | - Default Route Auto Assigned 

© • Static Routing Table None 

© | ^Load Balancing Dptions Destination-Based 

© • R o u t i n g Table Export Once at End of Simulation 

© |— Multipath Routes Threshold Unlimited 

© [-Administrative Weights (....) 

© | - 0 S Version Not Set 

© [+1 Extended ACL Configuration None 

© r+1 Prefix Filter Configuration None 

© 0 R o u t e Map Configuration |[...) 

© | - rows 1 

• row 0 

© | - M a p Label Route Map 1 

© 0 M a p Configuration |(...) 

© | - rows 1 

• row 0 

© | -Term 10 

© • Match Info |[...) 

© | - rows 1 

Fl row 0 

© \- Match Property AS Path 

© | - Match Condition Contains 

© L Match Value 65300 

© • Set Info (...) 

© | - rows 1 

• row 0 

© | - Set Attribute Local Preference 

© |— Set Operation Set As [=] 

© L Set Value 1 

© L-Action Permit 

© L-Next Map Label Not Used 

© [+1VRF Configuration u m 
Apply Changes to Selected Objects 

Find Next 

r~ Advanced 

Cancel OK 

Obr. 1.24: Směrovací mapa směrovače "STAB_2" pro BGP 

V dalším kroku si přiřadíme naši nově vytvořenou směrovací mapu na PPP linku mezi směrovací S T A B 2 
a S T A B 3 . Takhle bude veškerá komunikace ze směrovače S T A B 2 určená pro AS 65300 podléhat nové 
směrovací mapě a tedy tato síťová komunikace bude upřednostňována přes směrovač S T A B l (a následně 
STAB_3). 

61. Pravým tlačítkem klikneme na směrovač S T A B 2 a vybereme položku Edit Attributes. 
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62. Nyní si přiřadíme směrovací mapu na požadované rozhraní: 
BGP Parameters —> Neighbor Information —» row 1 (to Remote AS 65300) 

63. Následně si nastavíme parametry směrovacího pravidla protokolu BGP na příslušném L3 rozhraní, viz 
obr. 1.25: 

• Route Map Route Map 1 
• Applicable Direction In 

Pracujeme pouze s rozhraním, které má IP adresu na směrovač S T A B 3 . V našem projektu je to rozhraní 
if 11 konkrétně na lince P P P E 3 mezi směrovačem S T A B 2 a S T A B 3 a IP adresa na dalším přeskoku, 
tedy na směrovací S T A B 3 , je 192.168.23.2, což je na směrovací S T A B 2 u BGP sousedů row 1. 

JHf j (STAB 2 ) A t t r i b u t e s B B " n j j < j 

Type; ! router Make: | c i s c o 7 2 0 4 

Attribute Value 

© • BGP Parameters (...) 

[— Status Enabled 

© | -Start Time constant (70) 

© 0 Neighbor Information (...) 

® | - rows 4 

[+ ] row 0 192.0.22.1,65100,No EBGP Multi... 

U row 1 

© - I P Address 192.0.23.2 

© -Remote AS 65300 

© -EBGPMul t ihop Setting No EBGPMult ihop • 
© [+1 Timers (...) J 
© \- Newt Hop Self Default 

© |- Update Source Not Used 

© |- Prefix Limit No Max Limit 

© \- Weight 100 

© \- S end-Community Disabled 

© PI Routing Policies |(...) 

© |~rows 1 

p ] r o w 0 

© \- Route Map Route Map 1 

© L-Applicable Direction In 

© p ] Route Filters None 

© | - V R F N a m e None 

© |- Address Family IPv4 

© |- Route File NOTJJSED 

© - Description N/A 

p j r o w 2 192.0.6.2,65200,No EBGP Multih... 

p ] r c ™ 3 192.0.4.2,65200,No EBGP Mul t ih . . . | 

© p i Timers (...) • r n 

I - Apply Changes to Selected Objects I - Advanced 

[ Find Next | Cancel OK 1 

Obr. 1.25: Přiřazení směrovací mapy na směrovací "STAB_2" pro BGP 
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1.4.3 Vytvoření nového scénáře s Firewallem a Virtuální privátní sítí 

V tomhle scénáři si prověříme zabezpečení části sítě prostřednictvím Firewallu s využitím virtuální 
privátní sítě V P N (Virtual Priváte Network). V P N se nejčastěji používá pro zabezpečení připojení do 
intranetu přes nechráněnou síť. Zabezpečení je zajištěno šifrováním uživatelské komunikace na úrovni 
síťové vrstvy, které je často označeno pojmem „IP tunneling" pomocí speciálního zařízení nazývaného 
Firewall. Je to síťové zařízení, jehož úlohou je oddělit sítě s různou úrovní důvěryhodnosti a kontrolovat 
tak tok dat mezi těmito sítěmi. Kontrola dat probíhá na základě pravidel, které určují podmínky a akce. 
Základní akcí je povolit či blokovat datový tok. 

V téhle části se věnujeme: 
• aplikování nového síťového zařízení - Firewallu 
• uplatnění virtuální privátní sítě 

64. Nejdříve se nastavíme na náš základní scénář pouze pro síťovou komunikaci s protokolem EIGRP. 
Přepneme se tedy do tohoto scénáře výběrem z hlavního menu Scenarios > Switch to Scenario > 
no_BGP 

65. Z hlavního menu nyní vybereme Scenarios > Duplicate Scenario... a zvolíme jméno nového scénáře 
" n o B G P V P N " , následně potvrdíme tlačítkem OK. 

66. V novém scénáři klikneme pravým tlačítkem myši na směrovač Router_21 a zvolíme položku Edit 
Attributes. V nově otevřeném okně nejprve zatrhneme položku Advanced a poté změníme model na 
ethernet2_slip8_firewall. 

67. Dále najdeme položku Proxy Server Information a zde rozklikneme položku rowl (Database). Pro 
položku Proxy Server Deployed zadáme hodnotu No, viz obr. 1.26. 
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^ j ( R ü u t e r _ Z l ) A t t r i b u t e s 

Type" firewall 

1 Attribute 

© p name Router_21 
© | h model ethernet2_slip8_firewall 
© [+]CPU Background Utilization None 
© [+]CPU Resource Parameters Single Processor 
© [+1EIGRP Parameters \U 
© 0 H S R P Parameters Not Configured 
© [+ ] IGMPHost Parameters I Default 
© [ + ] I G R P Parameters |(...) 
© 0 I P Multicast Parameters I Default 
© 0 I P Processing Information \U 
© [+] IP Routing Parameters \U 
© [+] IS-IS Parameters |(...) 
© f + J I ^ N Supported Profiles None 

© [ + 1 0 S PF Parameters |(...) 

© PI Proxy Server Information \U 
| - rows 110 

[TJrow 0 1 Custom Application,Yes„constant [0.00002] | 

© -Application Database 
- Proxy Server Deployed |No 

® - Latency [sees] exponential [0.00005] 
[+1 row 2 E maiLYes.No Latency T I 

• T 
I Apply Changes to Selected Objects 

Find Next 

I Advanced 

Cancel OK 

Obr. 1.26: Nastavení Firewallu 

Potvrdíme kliknutím na OK. 
Nyní je Firewall nakonfigurován tak, aby všechny dotazy na databázový server byly zahozeny a tím 
nemá jakákoliv stanice nebo skupina stanic v síti přístup k databázovému serveru. 
Předpokládejme, že potřebujeme stanici HOST_12 povolit přístup k databázovému serveru. Jelikož 
Firewall filtruje (zahazuje) všechny pakety mířící na databázový server, potřebujeme postavit V P N 
tunel, přes který stanice HOST_12 může přímo komunikovat s databázovým serverem. Firewal pak ve 
V P N tunelu nebude zahazovat pakety, jelikož budou zabaleny do dalšího IP datagramu (s 
modifikovanou IP hlavičkou) [6], 

68. Odebereme spojení mezi směrovačem Router_21 a přepínačem SW_21_B. 

69. Z palety objektů vložíme na plochu jeden nový směrovač ethernet4_slip8_gtwy, pojmenujeme jej 
"AUXRouter" a ještě vložíme jeden objekt IP VPN Config, pojmenujeme jej "VPNs". 

70. Dále pomocí technologie lOOOBaseX propojíme přepínač SW_21_B s nově vloženým směrovačem 
AUX_Router a následně směrovač AUX_Router s objektem Router_21, viz obr. 1.27. 
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71. Z kontextového menu objektu VPNs (IP V P N Config) vybere Edit Atttributes a u položky VPN 
Configuration nastavíme hodnotu rows na 1. V novém řádku nastavíme položky: 

• Tunnel Source Name: Router 12 
• Tunnel Destination Name: A U X Router 
• Remote Client List: HOST 12 

viz obr. 1.28. 

Hr](VPNs) A t t r i b u t 

Attribute 

© p name 

© h-model 
R V P N Configuration 

© h 

Value 

VPNs 
IP VPN Config 

1 

© |-Tunnel Source Name Flouter_12 

© \-Tunnel Destination Name AUX Router 

© [TjDelay Information None 

© |— 0peration Mode Compulsory 

© Q R e m o t e Client List (...) 

© |-rows 1 

©I 
p| row 0 

©I I Client Node Name HOST 12 

«I I • ! 
Apply Changes to Selected Objects 

Find Next | Cancel 

ľ - Advanced 

OK 

Obr. 1.28: Nastavení VPN tunelu 
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Tím jsme vytvořili IP tunel, přes který se pracovní stanice HOST_12 může jako jediná připojit k 
databázovému serveru DATABASE. 

1.5 Nastavení statistik pro simulaci 

Nyní máme vytvořené čtyři scénáře, jeden pouze s protokolem EIGRP s názvem "noBGP" , druhý 
v kombinaci obou protokolů EIGRP a BGP s názvem "withBGP", třetí se směrovacím pravidlem BGP 
protokolu s názvem "wi thBGPPol i cy" a čtvrtý s využitím V P N pod názvem " n o B G P F i r e w a l l V P N " . 
Nastavíme v každém scénáři statistiky, které budeme sledovat. 

72. Nejdříve nastavíme statistiky pro scénář "noBGP" . Přepneme se tedy do tohoto scénáře výběrem 
z hlavního menu Scenarios > Switch to Scenario > noBGP. 

73. Klikneme pravým tlačítkem na plochu a vybereme položku Choose Individual Statistics. Zmenu 
vybereme: 

Global Statistics —> Ethernet —> Delay (sec) 
Global Statistics —> Ftp —> Download Response Time (sec) 

Potvrdíme tlačítkem OK. 

74. Opět se vrátíme do individuálních statistik, nyní pro nastavení obou pracovních stanic. Pravým 
tlačítkem myši klikneme na objekt HOST_12 a vybereme položku Choose Individual Statistics. 
Z menu vybereme: 

Client DB —> Traffic Received (bytes/sec) 

Stejné statistiky stejným způsobem vybereme také pro objekt HOST_32. 

75. Nyní si na ploše označíme PPP linku mezi směrovací S T A B l a S T A B 2 , klikneme pravým tlačítkem 
a vybereme položku Choose Individual Statistics. Z menu vybereme: 

point-to-point —> throughput (bit/sec) ~ > 

Potvrdíme tlačítkem OK. 

76. Nyní si nastavíme statistiky pro scénář "withBGP". Přepneme se tedy do tohoto scénáře výběrem 
z hlavního menu Scenarios > Switch to Scenario > withBGP. 

77. Zopakujeme výběr sledovaných statistik z kroku 73 pro Ethernet a Ftp. 

78. Narozdíl od předešlého scénáře si vybereme další dvě PPP linky a to následovně: Zopakujeme výběr 
sledovaných statistik z bodu 75 pro PPP linku mezi směrovací STAB_2 a STAB_3 a potvrdíme 
tlačítkem OK. 
Zopakujeme výběr sledovaných statistik z bodu 75 pro PPP linku mezi směrovací STAB_1 a STAB_3 
a potvrdíme tlačítkem OK. 

79. Nyní si nastavíme statistiky pro scénář "wi thBGPPol icy" . Přepneme se tedy do tohoto scénáře 
výběrem z hlavního menu Scenarios > Switch to Scenario > withBGPPolicy. 

80. Zopakujeme výběr sledovaných statistik z bodu 73. 
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81. Nyní si nastavíme statistiky pro scénář " n o B G P F i r e w a l l V P N " . Přepneme se tedy do tohoto scénáře 
výběrem z hlavního menu Scenarios > Switch to Scenario > noBGPFirewallVPN. 

82. Zopakujeme výběr sledovaných statistik z kroku 74 pro obě pracovní stanice. 

83. Projekt si uložíme přes hlavní menu File > Save. 

84. Nyní zvolíme v hlavním menu Scenarios > Manage Scenarios... Tato volba nám zajistí, že budeme 
moci simulovat oba scénáře zároveň. Ve sloupci Results změníme pro všechny scénáře hodnotu 
uncollected na collect. Dobu trvání zvýšíme na 1 hodinu tak, že Sim Duration atribut změníme na 1 a 
Time Units změníme na hour(s) pro oba scénáře, viz obr. 1.29. 

- ^ M a n a g e Scenarios 

Project Name: |EIGRP_vs_BGP 

tt 1 Scenario Name J Saved 
Results Sim 

Duration 
Time 
Units 

M [no_BGP saved <collect> 1,0 hour(s) 

p with_BGP saved <collect> 1.0 hour(s) 
3 |with_BGP_Policy saved <collect> 1.0 hour(s) 

U no_BGP_Firewall_VPN 
1 saved <collect> 1.0 hour(s) 

1 1 
Discard Results Collect Results Cancel OK 

Obr. 1.29: Simulace všech čtyř scénářů 

Potvrdíme tlačítkem OK, poté se spustí simulace, viz obr. 1.30. Simulace bude trvat přibližně 2 
minuty. Po jejím dokončení potvrdíme tlačítkem Close. 

-«-| Simulation Sequence: EIGRP_vs_BGP-no_BGP _ l 
Simulation runs to go: 1 

Running: no_BGP 

r- Elapsed Time: — r- Estimated Remaining Time: — 
7s. 1m 49s. 

| 1 1 9 / 600 sim seconds 

Simulation Speed Messages] Memory Usage] Memory Statsj Profiling] 

I Current Simulation Speed [events/second] 
I Average Simulation Speed (events/second) 

1 ~ ~ \ 
100 150 

Simulated Time (seconds) 

Simulated Time: 1m 59s. Events: 2800000 
Speed: Average: 38048G events/sec. Current: 400000 events/sec. 

| ? Save output when stopping simulation 

Update 

.Resume | Stop Run Stop Sequence J Close 

Obr. 1.30: Průběh simulace 
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1.6 Zobrazení výsledku 

Jelikož jsme nastavili stejné statistiky pro oba scénáře, budeme porovnávat naměřené hodnoty zobou 
scénářů zároveň. 

85. Klikneme pravým tlačítkem na plochu a zvolíme položku Compare Results. 

86. V novém okně, viz obr. 1.31, změníme: 
• hodnotu položky z This Scenario na All Scenarios 
• hodnotu položky ze Stacked Statistics na Overlaid Statistics 
• hodnotu položky z As Is na time_average 

Compare RÖJ I t s 

Discrete Event Graphs Displayed Panel Graphs | 

Global Statistics 
Ethernet 

Delay isec) 

L - H Download Response Time l.sec] 
Object Statistics 

Enterprise Network 
+ } M STABJ STAB_3 [0] 
3 M STAB_2 =» STABJ [0] 
3 M S T A B J Í-> STAB_2 [D] 
MM WkstA 
3 - 1 WkstB 

Results Generated: 1S:2S:;3 XI 272D11 

Close 

Obr. 1.31: Porovnání naměřených hodnot 

87. Rozklikněte jednotlivé statistiky a analyzujte jejich grafy. Všechny grafy jsou zobrazeny na 
následujících obrázcích: 
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0,58 

0,18 -I 1 1 1 1 1 1 
0 50 100 150 200 250 300 350 400 

čas [s] 

Obr. 1.32: Stahování z FTP serveru - časová odezva v sekundách 
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spojení bod-bod mezi směrovací STAB_1 a STAB_2 

9 000 000,00 

8 000 000,00 

7 000 000,00 

ľ" 6 000 000,00 

t> 5000000,00 
0 ' 
c 

1 4 000 000,00 
o 

3 000 000,00 

2 000 000,00 

1 000 000,00 

0,00 

85 135 185 235 

čas [s] 
285 335 

Obr. 1.34: Propustnost linky "bod_bod" mezi směrovací STAB_1 a STAB_2 
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spojení bod-bod mezi směrovací STAB_1 a STAB_3 
2 300 000,00 

1 800 000,00 

g 1 300 000,00 

tn 
o 
c 
tn 

o. 800 000,00 o 

300 000,00 

-200 000,00 80 130 

protokol EIGRP přes BGP 

protokol EIGRP přes BGP s BGP Policy 

180 230 280 330 

čas [s] 

Obr. 1.35: Propustnost linky "bod_bod" mezi směrovači STAB_1 a STAB_3 
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spojení bod-bod mezi směrovací STAB_2 a STAB_3 

1500000 
w 
o 

w 1000000 
D 
Q. 

Q. 500000 

č a s [s] 

Obr. 1.36: Propustnost linky "bod_bod" mezi směrovací STAB_2 a STAB_3 

90 190 

průběh přijatých dat - klient databáze (HOST_12) 

89 990,00 

79 990,00 

69 990,00 

59 990,00 

49 990,00 

39 990,00 

29 990,00 

19 990,00 

9 990,00 

-10,00 

A / V  

i 
protokol EIGRP 

protokol EIGRP s VPN 

protokol EIGRP 

protokol EIGRP s VPN 

protokol EIGRP 

protokol EIGRP s VPN 

i 
290 390 

čas [s] 
490 590 

Obr. 1.37: Zobrazení průběhu stahování pro stanici HOST_12 - klient databáze 
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průběh přijatých dat - klient databáze (HOST_32) 

49 990,00 

39 990,00 

£ 29 990,00 

re 
« 19 990,00 
re 

9 990,00 

-10,00 
90 190 

protokol EIGRP 

protokol EIGRP s VPN 

290 390 
čas [s] 

490 590 

Obr. 1.38: Zobrazení průběhu stahování pro stanici HOST_32 - klient database 
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2. Analýza a popis dosažených výsledků 

Dosažené výsledky prokazují porovnatelnou průměrnou časovou odezvu v síti při obou protokolech, 
přičemž by bylo chybou porovnávat rychlost stahování z FTP serveru, Ethernetovou prodlevu nebo 
celkovou propustnost mezi linkami typu bod-bod. 

Důvod je zřejmý, jsou to dva odlišné primární scénáře lišící se zejména právě v tom, že scénář "EIGRP" 
používá pouze jediný autonomní systém na rozdíl od scénáře "wi thBGP", kde jsou autonomní systémy 
tři. 

Směrování mezi těmito třema odlišnými autonomními systémy by pouze prostřednictvým protokolu 
EIGRP nebylo možné a naopak pro směrování uvnitř domény prokazuje protokol EIGRP dostatečné 
rychlou konvergenci. 

Protokol BGP představuje prostředek pro umožnění směrování mezi třemi odlišnými autonomními 
systémy a zároveň nese (enkapsuluje) protocol EIGRP (nebo popřípadě i jiný protokol, jako například 
protokol RIP ve třetí úloze následující kapitoly), který následně zabezpečuje směrování uvnitř každého ze 
tří individuálních autonomních systémů. 

Zhodnocení stahování z FTP serveru: 
Stahování z FTP serveru, viz obr. 1.32, je do konce prvních lOOs dost rozptýlené přičemž poukazuje na 
velmi rychlé stahování pomocí protokolu EIGRP - jen 0,29s v čase 200s naproti protokolu EIGRP přes 
BGP kde v tom samém čase je čas stahování 0,46s, tento rozdíl má za následek velmi rychlá konvergence 
samotného protokolu EIGRP. Časová odezva stahování od času 160s pro oba scénáře téměř lineárně 
narůstá, přičemž stahování pouze prostřednictvím protokolu EIGRP je přibližně o 40 % rychlejší, tento 
časový rozdíl způsobuje kombinace obou protokolů a hlavně nutná enkapsulace EIGRP do BGP. 

Zhodnocení Ethernetové prodlevy 
V prvních přibližně 100 sekundách mají oba scénáře nepatrné kolísání ethernetové prodlevy kolem 12LIS, 

které následně exponenciálně pro oba scénáře narůstá, viz obr. 1.33. Ethernetová prodleva protokolu 
EIGRP přes BGP nabývá o něco vyšších hodnot v porovnání s protokolem EIGRP. Rozdíl je však velmi 
nepatrný a procentuálně představuje jenom 11 % okamžité ethernetové prodlevy obou scénářů. Maximální 
ethernetová prodleva protokolu EIGRP je 113 LIS a maximální ethernetová prodleva protokolů EIGRP přes 
BGP je 127LIS. 

Zhodnocení propustnosti linky "bod bod" mezi směrovací STAB 1 a STAB 2: 
Propustnost linky zaznamenává prudký nárůst do přibližně lOOs od začátku simulace přičemž výrazně 
rychlejší propustnost je u prvního scénáře s protokolem EIGRP, viz obr. 1.34. Rozdíl nárůstu propustnosti 
obou scénářů kolísá od 11 % do 50 %. Oba scénáře se se svou propustností prolínají pouze 2 krát 
s přibližně stejnou časovou odezvou. Nejvyšší propustnost má protokol EIGRP v čase 300s a to až 8,5 
Mbps a nejvyšší propustnost protokolu EIGRP přes BGP je v čase 260s a to 6,0 Mbps. Propustnost 
prvního scénáře je vyšší z důvodu potřeby enkapsulace EIGRP do BGP, čím vzniká dodatečné nežádoucí 
zpoždění. 

Zhodnocení propustnosti linky "bod bod" mezi směrovací STAB 1 a STAB 3: 
Tento směr vystupuje z grafu jako méně vytížený směr co se týče kolísání při vytížení dané PPP linky, viz 
obr. 1.35. Linka má maximální kapacitu E l , což je u plesiochronního stupně velikost přibližně 2 Mbps. 
Nejvyšší propustnost protokolu EIGRP přes BGP je v čase 330s a to 1,5 Mbps. Uplatněním směrovacího 
pravidla protokolu BGP ve třetím scénáři se však tato PPP linka vytíží na maximum, protože přes ni bude 
procházet kromě původní síťové komunikace také veškerá síťová komunikace do AS 65300 ze směrovače 
S T A B 2 , což způsobí možné překročení maximální kapacity linky celkem 18-krát až na maximum 
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kapacity 2,048 Mbps (El). Při vyřešení tohoto problému určitě pomůže zvětšit kapacitu linky o další 
přenosový stupeň a sice E3 (34 Mbps) nebo změnit BGP směrovací pravidlo na směrovací S T A B 2 . 

Zhodnocení propustnosti linky "bod bod" mezi směrovací STAB 2 a STAB 3: 
V rámci protokolu EIGRP přes BGP propustnost linky prudce narůstá až do lOOs s maximální hodnotou 
propustnosti 2,7 Mbps a následně až do času 160s mírně klesá a až do konce simulace nastává saturace 
propustnosti, viz obr. 1.36. Uplatněním třetího scénáře se směrovacím pravidlem protokolu BGP zůstává 
PPP linka pouze 1% vytížená a tak je její vytíženost téměř na nule. Veškerá komunikace směrující do AS 
65300 je nyní přesměrována na směrovač S T A B l . Propustnost na PPP lince mezi směrovací S T A B l a 
S T A B 3 tak prudce narostla v důsledku uplatněného směrovacího pravidla na směrovací S T A B 2 . 

Zhodnocení datových toků v rámci V P N tunelu: 
V rámci prvního scénáře mají všechny pracovní stanice v síti přístup k databázovému serveru a tedy i obě 
sledované pracovní stanice HOST12 a HOST32 vykazují určitý průběh přijatých dat směrem 
z databázového serveru. U první pracovní stanice HOST12 je nejvyšší průběh 0,54 Mbps a u druhé 
pracovní stanice HOST32 je 0,36 Mbps, viz obr. 1.37. Jakmile je ale v síti zaveden Firewall ve čtvrtém 
scénáři, dochází okamžitě k filtrování všech paketů mířících na databázový server a přístup je omezen 
pouze pro jednu pracovní stanici HOST12 přičemž ostatní dotazy, t.j. dotazy od ostatních pracovních 
stanic na databázový server, jsou Firewallem neustále zahazovaný, viz obr. 1.38. Pracovní stanice 
HOST12 tu dosahuje oproti prvnímu scénáři o něco větší průběh přijatých dat z databázového serveru -
až 0,67 Mbps, což je způsobeno vznikem IP tunelu prostřednictvím nové Virtuální privátní sítě a tím i 
urychlení datového toku. 
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3. Otázky u úkoly 

1. Změňte v kroku 33 všechny tři použité aplikace (Database Access, File Transfer a Telnet Session) z 
Heavy na Light, t.j. pouze na lehkou zátěž, simulujte oba scénáře dle bodu 84 a vyvoďte závěry z 
výsledků simulace. 

Odpověď: 
[Průběh simulace bude o něco kratší a také vytížení všech PPP páteřních linek bude prokazatelně menší] 

2. Vytvořte další scénář pro poruchu na PPP lince mezi směrovací S T A B l a S T A B 2 po uplynutí 100 
sekund s názvem "withFailure" Následně po simulaci se scénářem "wi thBGP" porovnejte 
směrovací tabulku směrovače S T A B 3 . 

Odpověď: 
[Jelikož se na PPP páteřní lince o velikosti E3 naskytne po uplynutí 100 sekund porucha, bude v rámci 
scénáře "wi thBGP" rozložena její zátěž na sousední dvě linky a tím i vzroste jejich vytížení, z AS 
65200 do AS 65100 a také z AS 65100 do AS6520 se bude směrovat výlučně přes směrovač " S T A B 3 " 
a pro tuto skutečnost nastane také aktualizace směrovací tabulky na tomto směrovací] 

3. Vytvořte další scénář s názvem "withRIP" duplikovaním scénáře "wi thBGP" a v tomto novém 
scénáři použijte protokol PJP (namísto původního EIGRP) jako vnitřně-doménový protokol pro AS 
65300. Analyzujte pak obsah směrovací tabulky směrovače S T A B 3 a směrovače S T A B l . 

Odpověď: 
[Oba směrovače po proběhnutí konvergence v síti obsahují informaci o možných směrovacích cestách, 
konkrétně směrovač " S T A B l " má nejrychlejší přístup do RIP kruhové topologie na směrovač " S T A B 3 " 
přes směrovač " S T A B 2 " kvůlu rychlejší PPP E3 lince, a to samé platí i pro směrovač " S T A B 3 " , to 
znamená že primárně bude oběma směrovací " S T A B l " a " S T A B 3 " využívána hlavně PPP E3 linka přes 
směrovač " S T A B 2 " , směrovací tabulka směrovače " S T A B l " bude kromě EIGRP a BGP záznamů nyní 
obsahovat i RIP aktualizace kruhové topologie s RIP směrovacím protokolem v rámci směrovače 
" S T A B 3 " ] 

4. Vytvořte další scénář s názvem " w i t h B G P P o l i c y L o o p " duplikovaním scénáře 
"wi thBGPPol i cy" a v tomhle scénáři použijte podobné směrovací pravidlo na směrovací S T A B l , 
t.j. směrování do AS 65300 přes S T A B 2 (mělo by tím dojít ke směrovací smyčce). 

Odpověď: 
[Při simulaci v síti bude zobrazeno varování o vynucené vzniknuté smyčce mezi dvěma směrovací 
" S T A B l " a " S T A B 2 " vzhledem na vytvořené BGP směrovací pravidla pro směrování do AS 65300, 
což je nutné minimálně na jednom ze směrovačů opravit pro bez-smyčkové směrování a chybějící další 
alternativní směrovací cestě.] 

5. Duplikujte scénář "wi thBGP" a vytvořte nový scénář se jménem " w i t h B G P F i r e w a l l V P N " , ve 
kterém vytvoříte stejné objekty pro V P N jako v kapitole 1.4.3 s tím rozdílem, že na přepínači 
" S W 2 1 B " doplníte ještě HTTP server a zajistíte následující chování: 

• přístup na databázový server bude možné pouze z pracovních stanic v AS 65100 
• přístup na webový server bude možné pouze z pracovních stanic v AS 65300 

Odpověď: 
[V nově vytvořeném scénáři přibude ještě jeden V P N tunel, přičemž objekt "Router_21" bude propouštět 
síťovou komunikaci na databázový server pouze pro pracovní stanice " O F F I C E L A N l l " a " H O S T 1 2 " 
z AS 65100 a zároveň bude propouštět síťovou komunikaci na webový server pouze pro pracovní stanice 
"OFFICE_LAN_31", "OFFICE_LAN_32" a " H O S T 3 2 " z AS 65300] 
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4. Závěr 

Řešená simulace je vypracována formou laboratorního úkolu se zaměřením se na modelování síťové 
komunikace v prostředí IT GURU pomocí dvou klíčových protokolů, EIGRP a BGP. Řešená topologie 
odpovídá reálnému síťovému modelu u poskytovatele telekomunikačních služeb pro množinu zákazníků 
s reálným síťovým provozem. 

Samotná použitá topologie je typu rozšířené kruhové topologie s koncovými síťovými zařízeními na 
koncových směrovacích. Právě koncová zařízení generují sledovaný datový tok typu Telnet, Ftp a 
databázové služby, který odpovídá velmi silnému zatížení v celé síti. Jako koncová zařízení jsou použita 
počítače, skupiny počítačů a servry a jako síťová zařízení jsou použity přepínače a směrovače pracující na 
druhé a třetí vrstvé referenčního modelu OSI. 

Pro logické spojení na páteřní kruhové topologii, tvořené PPP linkami, byla zvolena technologie rámcové 
plesiochronní digitální hierarchie s přenosovými kanály typu E l a E3, ve kterých se přenáší ethernetová 
data z okrajových kruhových topologií a tato komunikace probíhá na druhé vrstvě referenčního modelu 
OSI. 

Oba protokoly síťové vrstvy, EIGRP a BGP, pracují již na třetí vrstvě referenčního modelu OSI, přičemž 
v použitých scénářích se měří propustnost páteřních linek s použitím těchto protokolů. Práce poukazuje na 
nezbytnost mezi-doménového protokolu BGP při směrování mezi odlišnými autonomními systémy a 
popisuje možnost aplikování vnitřně-doménového protokolu EIGRP, který je směrován přes protokol 
BGP. 

Speciálním případem je uplatnění směrovacího pravidla v rámci BGP protokolu, kdy na jedném z cisco 
směrovacích na páteřní kruhové topologii je zadefinovaná BGP směrovací mapa, čím se značně změní 
vytížení sledované PPP linky v daném scénáři. 

V simulaci je také v samostatném scénáři řešena koncepce Virtuální privátní sítě s IP tunelem, kde 
speciální síťové zařízení pod názvem Firevvall filtruje síťovou komunikaci a tím i přístup na konkrétní 
síťový prvek, kterým je datový server, a umožňuje tak přístup pouze vybraným účastníkům v rámci 
šifrované síťové komunikace přes V P N tunel. 

Oba analyzované protokoly, EIGRP a BGP, navzájem spolupracují při simulovaném zatížení celé sítě 
pomocí datového provozu, což je doplněno výslednou analýzou s grafy. Závěrečné úkoly pak řeší změnu a 
doplnění dalších scénářů pro dosažení modifikovaných výsledků. 
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Abecední přehled použitých zkratek 

AS Autonomous System 
BGP Border Gateway Protocol 
CIDR Classless Inter Domain Routing 
DUAL Diffusing Update ALgorithm 
IGRP Interior Gateway Routing Protocol 
EIGRP Enhanced Interior Gateway Routing Protocol 
ETH Ethernet 
FD Feasible Distance 
IP Internet Protocol 
ISP Internet Service Provider 
L3 Layer 3 
L A N Local Area Network 
OSI Open System Interconnect 
OSPF Open Shortest Path First 
PPP Point to point 
RIP Routing Information Protocol 
RD Reported Distance 
TCP Transmission Control Protocol 
V L S M Variable Length Subnet Mask 
V P N Virtual Private Network 
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